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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets
you fly! We designed Feather to be a new standard for portable microcontroller cores.

This is the Adafruit Feather 32u4 Bluefruit - our take on an 'all-in-one' Arduino-compatible +
Bluetooth Low Energy with built in USB and battery charging. Its an Adafruit Feather 32u4 with a
BTLE module, ready to rock! We have other boards in the Feather family, check'em out
here (http://adafru.it/jAQ)

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless protocol. In
particular, its the only wireless protocol that you can use with iOS without needing special
certification and it's supported by all modern smart phones. This makes it excellent for use in
portable projects that will make use of an iOS or Android phone or tablet. It also is supported in Mac
OS X and Windows 8+
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At the Feather 32u4's heart is at ATmega32u4 clocked at 8 MHz and at 3.3V logic, a chip setup
we've had tons of experience with as it's the same as the Flora (http://adafru.it/dVl). This chip has
32K of flash and 2K of RAM, with built in USB so not only does it have a USB-to-Serial program &
debug capability built in with no need for an FTDI-like chip, it can also act like a mouse, keyboard,
USB MIDI device, etc.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium
polymer batteries and built in battery charging. You don't need a battery, it will run just fine straight
from the micro USB connector. But, if you do have a battery, you can take it on the go, then plug in
the USB to recharge. The Feather will automatically switch over to USB power when its available.
We also tied the battery thru a divider to an analog pin, so you can measure and monitor the battery
voltage to detect when you need a recharge.
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Here's some handy specs! Like all Feather 32u4's you get:

Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 5.7 grams
ATmega32u4 @ 8MHz with 3.3V logic/power
3.3V regulator with 500mA peak current output
USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins
Hardware Serial, hardware I2C, hardware SPI support
8 x PWM pins
10 x analog inputs
Built in 100mA lipoly charger with charging status indicator LED
Pin #13 red LED for general purpose blinking
Power/enable pin
4 mounting holes
Reset button

The Feather 32u4 Bluefruit LE uses the extra space left over to add our excellent Bluefruit BTLE
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module + two status indicator LEDs

The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-function code
that can do quite a lot! For most people, they'll be very happy to use the standard Nordic UART
RX/TX connection profile. In this profile, the Bluefruit acts as a data pipe, that can 'transparently'
transmit back and forth from your iOS or Android device. You can use our iOS
App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), or write your own to communicate with
the UART service (http://adafru.it/iCF).

The board is capable of much more than just sending strings over the air!  Thanks to an easy to
learn AT command set (http://adafru.it/iCG), you have full control over how the device behaves,
including the ability to define and manipulate your own GATT Services and
Characteristics (http://adafru.it/iCH), or change the way that the device advertises itself for other
Bluetooth Low Energy devices to see. You can also use the AT commands  to query the die
temperature, check the battery voltage, and more, check the connection RSSI or MAC address, and
tons more. Really, way too long to list here!

Use the Bluefruit App to get your project started

Using our Bluefruit iOS App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), you can quickly
get your project prototyped by using your iOS or Android phone/tablet as a controller. We have
a color picker (http://adafru.it/iCI), quaternion/accelerometer/gyro/magnetometer or location

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 12 of 170

../../../../bluefruit-le-connect-for-ios
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect&hl=en
../../../../introducing-the-adafruit-bluefruit-le-uart-friend/uart-service
../../../../introducing-the-adafruit-bluefruit-le-uart-friend/command-mode-1
../../../../introducing-the-adafruit-bluefruit-le-uart-friend/ble-gatt
../../../../bluefruit-le-connect-for-ios
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect&hl=en
../../../../bluefruit-le-connect-for-ios/controller#color-picker
../../../../bluefruit-le-connect-for-ios/controller#sensors


(GPS) (http://adafru.it/iCI), and an 8-button control game pad (http://adafru.it/iCI). This data can be
read over BLE and piped into the ATmega32u4 chip for processing & control

You can do a lot more too!

The Bluefruit can also act like an HID Keyboard (http://adafru.it/iOA) (for devices that support
BLE HID)
Can become a BLE Heart Rate Monitor (http://adafru.it/iOB) (a standard profile for BLE) - you
just need to add the pulse-detection circuitry
Turn it into a UriBeacon (http://adafru.it/iOC), the Google standard for Bluetooth LE beacons.
Just power it and the 'Friend will bleep out a URL to any nearby devices with the UriBeacon
app installed.
Built in over-the-air bootloading capability so we can keep you updated with the hottest new
firmware (http://adafru.it/iOD). Use any Android or iOS device to get updates and install them.
This will update the native code on the BLE module, to add new wireless capabilities, not
program the ATmega chip.

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the
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Arduino IDE. We also toss in some header so you can solder it in and plug into a solderless
breadboard. Lipoly battery, MicroSD card and USB cable not included (but we do have lots of
options in the shop if you'd like!)
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Pinouts
The Feather 32u4 Bluefruit LE is chock-full of microcontroller goodness. There's also a lot of pins
and ports. We'll take you a tour of them now!

Power Pins
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GND - this is the common ground for all power and logic
BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery
USB - this is the positive voltage to/from the micro USB jack if connected
EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the
3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins
This is the general purpose I/O pin set for the microcontroller. All logic is 3.3V

#0 / RX - GPIO #0, also receive (input) pin for Serial1 and Interrupt #2
#1 / TX - GPIO #1, also transmit (output) pin for Serial1 and Interrupt #3
#2 / SDA - GPIO #2, also the I2C (Wire) data pin. There's no pull up on this pin by default so
when using with I2C, you may need a 2.2K-10K pullup. Also Interrupt #1
#3 / SCL - GPIO #3, also the I2C (Wire) clock pin. There's no pull up on this pin by default so
when using with I2C, you may need a 2.2K-10K pullup. Can also do PWM output and act as
Interrupt #0.
#5 - GPIO #5, can also do PWM output
#6 - GPIO #6, can also do PWM output and analog input A7
#9 - GPIO #9, also analog input A9 and can do PWM output. This analog input is connected
to a voltage divider for the lipoly battery so be aware that this pin naturally 'sits' at around
2VDC due to the resistor divider
#10 - GPIO #10, also analog input A10 and can do PWM output.
#11 - GPIO #11, can do PWM output.
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#12 - GPIO #12, also analog input A11 and can do PWM output.
#13 - GPIO #13, can do PWM output and is connected to the red LED next to the USB jack
A0 thru A5 - These are each analog input as well as digital I/O pins.
SCK/MOSI/MISO - These are the hardware SPI pins, used by the Bluefruit LE module too!
You can use them as everyday GPIO pins if you don't activate the Bluefruit and keep the BLE
CS pin high. However, we really recommend keeping them free as they should be kept
available for the Bluefruit. If they are used, make sure its with a device that will kindly share
the SPI bus! Also used to reprogram the chip with an AVR programmer if you need.

Bluefruit LE Module + Indicator LEDs

Since not all pins can be brought out to breakouts, due to the small size of the Feather, we use
these to control the BLE module

#8 - used as the Bluefruit CS (chip select) pin
#7 - used as the Bluefruit IRQ (interrupt request) pin.
#4 - used as the Bluefruit Reset pin

Since these are not brought out there should be no risk of using them by accident!

Other Pins!
RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the
bootloader manually
ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic
voltage (3.3V) but if you need an alternative analog reference, connect it to this pin and select
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the external AREF in your firmware. Can't go higher than 3.3V!
DFU - this is the force-DFU (device firmware upgrade) pin for over-the-air updates to the
Bluefruit module. You probably don't need to use this but its available if you need to upgrade! 
Check out the DFU Bluefruit Upgrades page for how to use it. Otherwise, keep it
disconnected.

On the back we also have SWDIO/SWCLK/RST pins, these are used for programming the Bluefruit
LE module itself. You should not connect to these, unless you want to wipe out the Bluefruit LE
module firmware for some reason. The RST pin is the factory reset pin, which is also rarely used,
but you can use it to set the module back to the factory default settings if it gets really messed up.
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Power Management

Battery + USB Power
We wanted to make the Feather easy to power both when connected to a computer as well as via
battery. There's two ways to power a Feather. You can connect with a MicroUSB cable (just plug
into the jack) and the Feather will regulate the 5V USB down to 3.3V. You can also connect a
4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium Ion (LiIon) battery to the JST jack. This will let the
Feather run on a rechargable battery. When the USB power is powered, it will automatically
switch over to USB for power, as well as start charging the battery (if attached) at 100mA.
This happens 'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that
will only get used when USB power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator
and changeover diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right
of the Reset button). There's also a CHG LED, which will light up while the battery is charging. This
LED might also flicker if the battery is not connected.

Power supplies
You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly
JST connector, as well as USB which is the +5V from USB if connected. We also have the 3V pin
which has the output from the 3.3V regulator. We use a 500mA peak SPX3819. While you can get
500mA from it, you can't do it continuously from 5V as it will overheat the regulator. It's fine for, say,
powering an ESP8266 WiFi chip or XBee radio though, since the current draw is 'spiky' & sporadic.
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Measuring Battery
If you're running off of a battery, chances are you wanna know what the voltage is at! That way you
can tell when the battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick
around 3.7V for much of the battery life, then slowly sink down to 3.2V or so before the protection
circuitry cuts it off. By measuring the voltage you can quickly tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9
(a.k.a analog #9 A9). You can read this pin's voltage, then double it, to get the battery voltage.

#define VBATPIN A9
   
float measuredvbat = analogRead(VBATPIN);
measuredvbat *= 2;    // we divided by 2, so multiply back
measuredvbat *= 3.3;  // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage
Serial.print("VBat: " ); Serial.println(measuredvbat);
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ENable pin
If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to
Ground and it will disable the 3V regulator. The BAT and USB pins will still be powered
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Arduino IDE Setup
The first thing you will need to do is to download the latest release of the Arduino IDE. You will need
to be using version 1.6.4 or higher for this guide.

Arduino IDE v1.6.4+ Download

http://adafru.it/f1P

After you have downloaded and installed v1.6.4, you will need to start the IDE and navigate to the
Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino
menu on OS X.

A dialog will pop up just like the one shown below.
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We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is
comma separated, and you will only have to add each URL once. New Adafruit boards and updates
to existing boards will automatically be picked up by the Board Manager each time it is opened. The
URLs point to index files that the Board Manager uses to build the list of available & installed
boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs
on the Arduino IDE wiki (http://adafru.it/f7U). We will only need to add one URL to the IDE in this
example, but you can add multiple URLS by separating them with commas. Copy and paste
the link below into the Additional Boards Manager URLs option in the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json
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Here's a short description of each of the Adafruit supplied packages that will be available in the
Board Manager when you add the URL:

Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket
Pro.
Adafruit SAMD Boards - Includes support for Feather M0
Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora,
Feather 32u4, Micro and Leonardo using the arcore project (http://adafru.it/eSI).

Click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Make sure you remove the apt.adafruit.com proxy setting from the Arduino preferences if you
have previously added it.�
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Using with Arduino IDE
Since the Feather 32u4 uses an ATmega32u4 chip running at 8 MHz, you can pretty easily get it
working with the Arduino IDE. Many libraries (including the popular ones like NeoPixels and display)
work great with the '32u4 and 8 MHz clock speed.

Now that you have added the appropriate URLs to the Arduino IDE preferences, you can open the
Boards Manager by navigating to the Tools->Board menu.

Once the Board Manager opens, click on the category drop down menu on the top left hand side of
the window and select Contributed. You will then be able to select and install the boards
supplied by the URLs added to the prefrences. In the example below, we are installing support
for Adafruit AVR Boards, but the same applies to all boards installed with the Board Manager.

Next, quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You
should now be able to select and upload to the new boards listed in the Tools->Board menu.
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Install Drivers (Windows Only)
When you plug in the Feather, you'll need to possibly install a driver

Start out by installing the serial/CDC drivers. We'll be using PJRC's awesome generic CDC drivers,
works with all Windows and all CDC devices. (Thanks Paul!) (http://adafru.it/fLA)

Mac/Linux does not need a driver, continue as is!

Blink
Now you can upload your first blink sketch!

Plug in the Feather 32u4 and wait for it to be recognized by the OS (just takes a few seconds). It will
create a serial/COM port, you can now select it from the dropdown, it'll even be 'indicated' as
Feather 32u4!
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Now load up the Blink example

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the
delay() calls.

Manually bootloading
If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and
doesn't auto-reboot into the bootloader, click the RST button to get back into the bootloader. The
red LED will pulse, so you know that its in bootloader mode. Do the reset button press right as the
Arduino IDE says its attempting to upload the sketch, when you see the Yellow Arrow lit and the
Uploading... text in the status bar.

// the setup function runs once when you press reset or power the board
void setup() {
  // initialize digital pin 13 as an output.
  pinMode(13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
  digitalWrite(13, HIGH);   // turn the LED on (HIGH is the voltage level)
  delay(1000);              // wait for a second
  digitalWrite(13, LOW);    // turn the LED off by making the voltage LOW
  delay(1000);              // wait for a second
}
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Don't click the reset button before uploading, unlike other bootloaders you want this one to run at
the time Arduino is trying to upload

Ubuntu & Linux Issue Fix

Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an
issue with the modem manager service which causes the Bluefruit LE micro to be difficult to
program.  If you run into errors like "device or resource busy", "bad file descriptor", or "port is busy"
when attempting to program then you are hitting this issue. (http://adafru.it/fP6)

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system.  One
of these rules is made to configure modem manager not to touch the Bluefruit Micro board and will
fix the programming difficulty issue.  Follow the steps for installing Adafruit's udev rules on this
page. (http://adafru.it/iOE)
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Installing BLE Library
Install the Adafruit nRF51 BLE Library
In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based
modules such as this one (a.k.a. Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (http://adafru.it/f4V) but its likely easier to just download
by clicking:

Download the Adafruit nRF51
BluefruitLE Library

http://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the
Adafruit_BluefruitLE_nRF51 folder contains Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a
bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolder/libraries/ folder. 
You may need to create the libraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (http://adafru.it/aYM)

After restarting, check that you see the library folder with examples:
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Run first example
Lets begin with the beginner project, which we can use to do basic tests. To open the ATCommand
sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and
select atcommand:

This will open up a new instance of the example in the IDE, as shown below:
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Go to the second tab labeled BluefruitConfig.h and find these lines

Don't upload the sketch yet! You will have to begin by changing the configuration.�
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And change the last line to:

(The Bluefruit Feather has the reset on digital #4 not #6)

Now go back to the main tab atcommand and look for this line of code

Make sure that the second line is uncommented (it should be)

Uploading to the Feather Bluefruit LE
It's pretty easy to upload, first up make sure you have Adafruit Feather 32u4 selected on the
boards dropdown as above. Also, in the Ports menu, look for the port labeled as such:

// SHARED SPI SETTINGS
// ----------------------------------------------------------------------------------------------
// The following macros declare the pins to use for HW and SW SPI communication.
// SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when
// using HW SPI.  This should be used with nRF51822 based Bluefruit LE modules
// that use SPI (Bluefruit LE SPI Friend).
// ----------------------------------------------------------------------------------------------
#define BLUEFRUIT_SPI_CS               8
#define BLUEFRUIT_SPI_IRQ              7
#define BLUEFRUIT_SPI_RST              6    // Optional but recommended, set to -1 if unused

#define BLUEFRUIT_SPI_RST              4   // Optional but recommended, set to -1 if unused

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

OK now you can upload to the Bluefruit Feather!�

If you're using Ubuntu 15.04 or other Linux distributions and run into errors attempting to
upload a program to the board, scroll up to the Ubuntu and Linux issue fix in the previous
section

�
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Now click the upload button on the Arduino IDE (or File Menu -> Upload)

If all is good you will see Done Uploading in the status bar
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Uploading to a brand new board/Upload failures

If you are uploading for the first time to a new board, or if upload fails, pres the RESET mini button
on the Feather 32u4 Bluefruit when you see the Yellow Arrow lit and the Uploading... text in the
status bar. When you see the red LED pulsing on and off, you know the bootloader is running.
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Don't click the reset button before uploading, unlike other bootloaders you want this one to run at
the time Arduino is trying to upload

Run the sketch
OK check again that the correct port is selected

Then open up the Serial console. You will see the following:

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 37 of 170



This sketch starts by doing a factory reset, then querying the BLE radio for details. These details will
be useful if you are debugging the radio. If you see the information as above, you're working! (Note
that the dates and version numbers may vary)

AT command testing
Now you can try out some AT commands - check the rest of the learn guide for a full list. We'll just
start with AT+HWGETDIETEMP which will return the approximate ambient temperature of the BLE
chipset
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OK now you know how to upload/test/communicate with your Feather 32u4 Bluefruit. Next up we
have a bunch of tutorials who can follow for checking out the bluetooth le radio and apps.

For all the following examples, we share the same code between various modules so don't forget
to make sure you have the RESET pin set to 4 in BluefruitConfig.h for each sketch before
uploading, and that Hardware SPI mode is selected by checking for

      /* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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Configuration!

Which board do you have?
There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you
have an SPI-connected NRF51822 module. You
can use this with Atmega328 (Arduino UNO or
compatible), ATmega32u4 (Arduino Leonardo,
compatible) or ATSAMD21 (Arduino Zero,
compatible) and possibly others. 
Your pinouts are Hardware SPI, CS = 8, IRQ = 7,
RST = 4

Bluefruit Micro or Feather 32u4
Bluefruit
If you have a Bluefruit Micro or Feather 32u4
Bluefruit LE then you have an ATmega32u4 chip
with Hardware SPI, CS = 8, IRQ = 7, RST = 4

Feather M0 Bluefruit LE
If you have a Feather M0 Bluefruit LE then you
have an ATSAMD21 chip with Hardware SPI, CS =

Before you start uploading any of the example sketches, you'll need to CONFIGURE the
Bluefruit interface - there's a lot of options so pay close attention!�
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8, IRQ = 7, RST = 4

Bluefruit LE SPI Friend
If you have a stand-alone module, you have a bit of
flexibility with wiring however we strongly
recommend Hardware SPI, CS = 8, IRQ = 7, RST =
4

You can use this with just about any microcontroller
with 5 or 6 pins

Bluefruit LE UART Friend or Flora
BLE
If you have a stand-alone UART module you have
some flexibility with wiring. However we suggest
hardware UART if possible. You will likely need to
use the flow control CTS pin if you are not using
hardware UART. There's also a MODE pin

You can use this with just about any microcontroller
with at least 3 pins, but best used with a Hardware
Serial/UART capable chip!
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Configure the Pins Used
You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the
sketch to your own documents folder once set up.
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to
have full debug output. Debug output is 'noisy' on the serial console but is handy since you can see
all communication between the micro and the BLE

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and
CTS flow control. Some microcontrollers are limited on which pins can be used! Check the
SoftwareSerial library documentation for more details

// ----------------------------------------------------------------------------------------------
// These settings are used in both SW UART, HW UART and SPI mode
// ----------------------------------------------------------------------------------------------
#define BUFSIZE                        128   // Size of the read buffer for incoming data
#define VERBOSE_MODE                   true  // If set to 'true' enables debug output

// SOFTWARE UART SETTINGS
#define BLUEFRUIT_SWUART_RXD_PIN       9    // Required for software serial!
#define BLUEFRUIT_SWUART_TXD_PIN       10   // Required for software serial!
#define BLUEFRUIT_UART_CTS_PIN         11   // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN         -1   // Optional, set to -1 if unused
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Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Serial1 - you can set that up here:

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few
sketches that dont use it, instead depending on commands to set/unset the mode. Its best to use
the MODE pin if you have a GPIO to spare!

SPI Pins

For both Hardware and Software SPI, you'll want to set the CS (chip select) line, IRQ (interrupt
request) line and if you have a pin to spare, RST (Reset)

Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but
very flexible

// HARDWARE UART SETTINGS
#ifdef Serial1    // this makes it not complain on compilation if there's no Serial1
  #define BLUEFRUIT_HWSERIAL_NAME      Serial1
#endif

#define BLUEFRUIT_UART_MODE_PIN        12    // Set to -1 if unused

// SHARED SPI SETTINGS
#define BLUEFRUIT_SPI_CS               8
#define BLUEFRUIT_SPI_IRQ              7
#define BLUEFRUIT_SPI_RST              4    // Optional but recommended, set to -1 if unused

// SOFTWARE SPI SETTINGS
#define BLUEFRUIT_SPI_SCK              13
#define BLUEFRUIT_SPI_MISO             12
#define BLUEFRUIT_SPI_MOSI             11

Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!�
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Select the Serial Bus
Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt
the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the
HW you are using: SPI both hardware and software type, and UART both hardware and software
type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can use either software serial or
hardware serial. Hardware serial is higher quality, and less risky with respect to losing data.
However, you may not have hardware serial available! Software serial does work just fine with flow-
control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial
contructor below, and make sure the other three options (hardware serial & SPI) are commented
out.

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial
constructor, and make sure the other three options are commented out

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure
the other constructors are commented out:

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial(BLUEFRUIT_SWUART_TXD_PIN, BLUEFRUIT_SWUART_RXD_PIN

Adafruit_BluefruitLE_UART ble(bluefruitSS, BLUEFRUIT_UART_MODE_PIN,
                      BLUEFRUIT_UART_CTS_PIN, BLUEFRUIT_UART_RTS_PIN);

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */
Adafruit_BluefruitLE_UART ble(BLUEFRUIT_HWSERIAL_NAME, BLUEFRUIT_UART_MODE_PIN);

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI
transfers via the following constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_SCK, BLUEFRUIT_SPI_MISO,
                             BLUEFRUIT_SPI_MOSI, BLUEFRUIT_SPI_CS,
                             BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);
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BLEUart
The BLEUart example sketch allows you to send and receive text data between the Arduino and a
connected Bluetooth Low Energy Central device on the other end (such as you mobile phone using
the Adafruit Bluefruit LE Connect application for Android (http://adafru.it/f4G) or
iOS (http://adafru.it/f4H) in UART mode).

Opening the Sketch
To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51
folder in the Arduino IDE and select bleuart_cmdmode:

This will open up a new instance of the example in the IDE, as shown below:
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Configuration
Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or
Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
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This tutorial does not need to use the MODE pin, make sure you have the mode switch in
CMD mode if you do not configure & connect a MODE pin
Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using
it! (The Flora has this already done)

Running the Sketch
Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload
process has finished, open up the Serial Monitor via Tools > Serial Monitor, and make sure that
the baud rate in the lower right-hand corner is set to 115200:

Once you see the request, use the App to connect to the Bluefruit LE module in UART mode so you
get the text box on your phone
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Any text that you type in the box at the top of the Serial Monitor will be sent to the connected phone,
and any data sent from the phone will be displayed in the serial monitor:

You can see the incoming string here in the Adafruit Bluefruit LE Connect app below (iOS in this
case):
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The response text ('Why hello, Arduino!') can be seen below:
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HIDKeyboard
The HIDKeyboard example shows you how you can use the built-in HID keyboard AT commands to
send keyboard data to any BLE-enabled Android or iOS phone, or other device that supports BLE
HID peripherals.

Opening the Sketch
To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51
folder in the Arduino IDE and select hidkeyboard:

This will open up a new instance of the example in the IDE, as shown below:
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Configuration
Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or
Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

This tutorial does not need to use the MODE pin, make sure you have the mode switch in
CMD mode!
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Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using
it! (The Flora has this already done)

Running the Sketch
Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload
process has finished, open up the Serial Monitor via Tools > Serial Monitor, and make sure that
the baud rate in the lower right-hand corner is set to 115200:
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To send keyboard data, type anything into the textbox at the top of the Serial Monitor and click
the Send button.

Bonding the HID Keyboard
Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC.  The bonding
process establishes a permanent connection between the two devices, meaning that as soon as
your phone or PC sees the Bluefruit LE module again it will automatically connect.

The exact procedures for bonding the keyboard will varying from one platform to another.

Android
To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to the Settings
application and click the Bluetooth icon.

When you no longer need a bond, or wish to bond the Bluefruit LE module to another device,
be sure to delete the bonding information on the phone or PC, otherwise you may not be able
to connect on a new device!

�

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The exact
appearance may vary depending on your device and OS version.�
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Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising itself
as Bluefruit Keyboard under the 'Available devices' list:

Tapping the device will start the bonding process, which should end with the Bluefruit Keyboard
device being moved to a new 'Paired devices' list with 'Connected' written underneath the device
name:
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To delete the bonding information, click the gear icon to the right of the device name and the click
the Forget button:

iOS
To bond the keyboard on an iOS device, go to the Settings application on your phone, and click
the Bluetooth menu item.

The keyboard should appear under the OTHER DEVICES list:
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Once the bonding process is complete the device will be moved to the MY DEVICES category, and
you can start to use the Bluefruit LE module as a keyboard:
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To unbond the device, click the 'info' icon and then select the Forget this Device option in the
menu:

OS X
To bond the keyboard on an OS X device, go to the Bluetooth Preferences window and click
the Pair button beside the Bluefruit Keyboard device generated by this example sketch:
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To unbond the device once it has been paired, click the small 'x' icon beside Bluefruit Keyboard:
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... and then click the Remove button when the confirmation dialogue box pops up:
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Controller
The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a hand-held
controller or an external data source, taking advantage of the wealth of sensors on your phone or
tablet.

You can take accelerometer or quaternion data from your phone, and push it out to your Arduino via
BLE, or get the latest GPS co-ordinates for your device without having to purchase (or power!) any
external HW.

Opening the Sketch
To open the Controller sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder
in the Arduino IDE and select controller:

This will open up a new instance of the example in the IDE, as shown below:
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Configuration
Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or
Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

This tutorial will also be easier to use if you wire up the MODE pin, you can use any pin but
our tutorial has pin 12 by default. You can change this to any pin. If you do not set the MODE
pin then make sure you have the mode switch in CMD mode
If you are using a Flora or otherwise don't want to wire up the Mode pin, set the
BLUEFRUIT_UART_MODE_PIN to -1 in the configuration tab so that the sketch will use the
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+++ method to switch between Command and Data mode!
Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using
it! (The Flora has this already done)

Running the Sketch
Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload
process has finished, open up the Serial Monitor via Tools > Serial Monitor, and make sure that
the baud rate in the lower right-hand corner is set to 115200:

Using Bluefruit LE Connect in Controller Mode
Once the sketch is running you can open Adafruit's Bluefruit LE Connect application (available for
Android (http://adafru.it/f4G) or iOS (http://adafru.it/f4H)) and use the Controller application to
interact with the sketch.  (If you're new to Bluefruit LE Connect, have a look at our dedicated
Bluefruit LE Connect learning guide (http://adafru.it/iCm).)
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On the welcome screen, select the Adafruit Bluefruit LE device from the list of BLE devices in
range:

Then from the activity list select Controller:

This will bring up a list of data points you can send from your phone or tablet to your Bluefruit LE
module, by enabling or disabling the appropriate sensor(s).

Streaming Sensor Data
You can take Quaternion (absolute orientation), Accelerometer, Gyroscope, Magnetometer or GPS
Location data from your phone and send it directly to your Arduino from the Controller activity.
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By enabling the Accelerometer field, for example, you should see accelerometer data update in the
app:

The data is parsed in the example sketch and output to the Serial Monitor as follows:

Accel 0.20 -0.51 -0.76
Accel 0.22 -0.50 -0.83
Accel 0.25 -0.51 -0.83
Accel 0.21 -0.47 -0.76
Accel 0.27 -0.48 -0.82
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Note that even though we only print 2 decimal points, the values are received from the App as a full
4-byte floating point.

Control Pad Module
You can also use the Control Pad Module to capture button presses and releases by selecting the
appropriate menu item:

This will bring up the Control Pad panel, shown below:
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Button presses and releases will all be logged to the Serial Monitor with the ID of the button used:

Color Picker Module
You can also send RGB color data via the Color Picker module, which presents the following color
selection dialogue:

Button 8 pressed
Button 8 released
Button 3 pressed
Button 3 released
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This will give you Hexadecimal color data in the following format:

You can combine the color picker and controller sample sketches to make color-configurable
animations triggered by buttons in the mobile app-- very handy for wearables! Download this
combined sample code (configured for Feather but easy to adapt to FLORA, BLE Micro, etc.) to get
started:

feather_bluefruit_neopixel_animation_
controller.zip

http://adafru.it/kzF

RGB #A42FFF
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HeartRateMonitor
The HeartRateMonitor example allows you to define a new GATT Service and associated GATT
Characteristics, and update the characteristic values using standard AT commands.

Opening the Sketch
To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51
folder in the Arduino IDE and select heartratemonitor:

This will open up a new instance of the example in the IDE, as shown below:
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Configuration
Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or
Software/Hardware SPI. The default is hardware SPI
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If Using Hardware or Software UART

This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD
mode if you do not configure & connect a MODE pin

This demo uses some long data transfer strings, so we recommend defining and connecting both
CTS and RTS to pins, even if you are using hardware serial.

If you are using a Flora or just dont want to connect CTS or RTS, set the pin #define's to -1 and
Don't forget to also connect the CTS pin on the Bluefruit to ground! (The Flora has this
already done)

If you are using RTS and CTS, you can remove this line below, which will slow down the data
transmission

Running the Sketch
Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload
process has finished, open up the Serial Monitor via Tools > Serial Monitor, and make sure that
the baud rate in the lower right-hand corner is set to 115200:

// this line is particularly required for Flora, but is a good idea 
  // anyways for the super long lines ahead!
  ble.setInterCharWriteDelay(5); // 5 ms
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If you open up an application on your mobile device or laptop that support the standard Heart Rate
Monitor Service (http://adafru.it/f4I), you should be able to see the heart rate being updated in sync
with the changes seen in the Serial Monitor:

nRF Toolbox HRM Example
The image below is a screenshot from the free nRF Toolbox (http://adafru.it/e9M) application from
Nordic on Android (also available on iOS (http://adafru.it/f4J)), showing the incoming Heart Rate
Monitor data:
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CoreBluetooth HRM Example
The image below is from a freely available CoreBluetooth sample
application (http://adafru.it/f4K) from Apple showing how to work with Bluetooth Low Energy services
and characteristics:
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UriBeacon
The UriBeacon example shows you how to use the built-in UriBeacon AT commands to configure
the Bluefruit LE module as a UriBeacon advertiser, following Google's Physical Web
UriBeacon (http://adafru.it/edk) specification.

Opening the Sketch
To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51
folder in the Arduino IDE and select uribeacon:

This will open up a new instance of the example in the IDE, as shown below. You can edit the URL
that the beacon will point to, from the default http://www.adafruit.com or just upload as is to test
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Configuration
Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or
Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

This tutorial does not need to use the MODE pin, make sure you have the mode switch in
CMD mode if you do not configure & connect a MODE pin
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Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using
it! (The Flora has this already done)

Running the Sketch
Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload
process has finished, open up the Serial Monitor via Tools > Serial Monitor, and make sure that
the baud rate in the lower right-hand corner is set to 115200:

At this point you can open the Physical Web Application for Android (http://adafru.it/edi) or for
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iOS (http://adafru.it/edj), and you should see a link advertising Adafruit's website: 
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�

�

HALP!
When using the Bluefruit Micro or a Bluefruit LE with Flora/Due/Leonardo/Micro the examples dont

run?
We add a special line to setup() to make it so the Arduino will halt until it sees you've connected
over the Serial console. This makes debugging great but makes it so you cannot run the
program disconnected from a computer.

Solution? Once you are done debugging, remove these two lines from setup()

I can't seem to "Find" the Bluefruit LE!
Getting something like this?

For UART/Serial Bluefruits:

Check you have the MODE switch in CMD and the MODE pin not wired to anything if it isnt
used!
If you are trying to control the MODE from your micro, make sure you set the MODE pin in the
sketch
Make sure you have RXI and TXO wired right! They are often swapped by accident

  while (!Serial);
  delay(500);
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Make sure CTS is tied to GND if you are using hardware serial and not using CTS
Check the MODE red LED, is it blinking? If its blinking continuously, you might be in DFU
mode, power cycle the module!
If you are using Hardware Serial/Software Serial make sure you know which one and have
that set up

If using SPI Bluefruit:

Make sure you have all 5 (or 6) wires connected properly.
If using hardware SPI, you need to make sure you're connected to the hardware SPI port,
which differs depending on the main chipset.

If using Bluefruit Micro:

Make sure you change the RESET pin to #4 in any Config file. Also be sure you are using
hardware SPI to connect!
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AT Commands
The Bluefruit LE modules use a Hayes AT-style command set  (http://adafru.it/ebJ)to configure the
device.

The advantage of an AT style command set is that it's easy to use in machine to machine
communication, while still being somewhat user friendly for humans.

Test Command Mode '=?'
'Test' mode is used to check whether or not the specified command exists on the system or not.  

Certain firmware versions or configurations may or may not include a specific command, and you
can determine if the command is present by taking the command name and appending '=?' to it, as
shown below

If the command is present, the device will reply with 'OK'.  If the command is not present, the device
will reply with 'ERROR'.

Write Command Mode '=xxx'
'Write' mode is used to assign specific value(s) to the command, such as changing the radio's
transmit power level using the command we used above.

To write a value to the command, simple append an '=' sign to the command followed by
any paramater(s) you wish to write (other than a lone '?' character which will be interpretted as tet
mode):

If the write was successful, you will generally get an 'OK' response on a new line, as shown below:

AT+BLESTARTADV=?

AT+BLESTARTADV=?
OK\r\n
AT+MISSINGCMD=?
ERROR\r\n

AT+BLEPOWERLEVEL=-8
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If there was a problem with the command (such as an invalid parameter) you will get an 'ERROR'
response on a new line, as shown below:

Note: This particular error was generated because '3' is not a valid value for the
AT+BLEPOWERLEVEL command.  Entering '-4', '0' or '4' would succeed since these are all valid
values for this command.

Execute Mode
'Execute' mode will cause the specific command to 'run', if possible, and will be used when the
command name is entered with no additional parameters.

You might use execute mode to perform a factory reset, for example, by executing the
AT+FACTORYRESET command as follows:

NOTE: Many commands that are means to be read will perform the same action whether they are
sent to the command parser in 'execute' or 'read' mode. For example, the following commands will
produce identical results:

If the command doesn't support execute mode, the response will normally be 'ERROR' on a new
line.

AT+BLEPOWERLEVEL=-8
OK\r\n

AT+BLEPOWERLEVEL=3
ERROR\r\n

AT+FACTORYRESET

AT+FACTORYRESET
OK\r\n

AT+BLEGETPOWERLEVEL
-4\r\n
OK\r\n
AT+BLEGETPOWERLEVEL?
-4\r\n
OK\r\n
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Read Command Mode '?'
'Read' mode is used to read the current value of a command. 

Not every command supports read mode, but you generally use this to retrieve information like the
current transmit power level for the radio by appending a '?' to the command, as shown below:

If the command doesn't support read mode or if there was a problem with the request, you will
normally get an 'ERROR' response.

If the command read was successful, you will normally get the read results followed by 'OK' on a
new line, as shown below:

Note: For simple commands, 'Read' mode and 'Execute' mode behave identically.

AT+BLEPOWERLEVEL?

AT+BLEPOWERLEVEL?
-4\r\n
OK\r\n
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Standard AT
The following standard Hayes/AT commands are available on Bluefruit LE modules:

AT
Acts as a ping to check if we are in command mode. If we are in command mode, we should receive
the 'OK' response.

Codebase Revision: 0.3.0

Parameters: None

Output: None

ATI
Displays basic information about the Bluefruit module.

Codebase Revision: 0.3.0

Parameters: None

Output: Displays the following values:

Board Name
Microcontroller/Radio SoC Name
Unique Serial Number
Core Bluefruit Codebase Revision
Project Firmware Revision
Firmware Build Date
Softdevice, Softdevice Version, Bootloader Version (0.5.0+)

AT
OK
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Updates:

Version 0.4.7+ of the firmware adds the chip revision after the chip name if it can be detected
(ex. 'nRF51822 QFAAG00').
Version 0.5.0+ of the firmware adds a new 7th record containing the softdevice, softdevice
version and bootloader version (ex. 'S110 7.1.0, 0.0').

ATZ
Performs a system reset.

Codebase Revision: 0.3.0

Parameters: None

Output: None

ATE
Enables or disables echo of input characters with the AT parser

Codebase Revision: 0.3.0

Parameters: '1' = enable echo, '0' = disable echo

Output: None

ATI
BLEFRIEND
nRF51822 QFAAG00
FB462DF92A2C8656
0.5.0
0.5.0
Feb 24 2015
S110 7.1.0, 0.0
OK

ATZ
OK
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+++
Dynamically switches between DATA and COMMAND mode without changing the physical
CMD/UART select switch.

When you are in COMMAND mode, entering '+++\n' or '+++\r\n' will cause the module to switch to
DATA mode, and anything typed into the console will go direct to the BLUE UART service.

To switch from DATA mode back to COMMAND mode, simply enter '+++\n' or '+++\r\n' again (be
sure to include the new line character!), and a new 'OK' response will be displayed letting you know
that you are back in COMMAND mode (see the two 'OK' entries in the sample code below).

Codebase Revision: 0.4.7

Parameters: None

Output: None

# Disable echo support
ATE=0
OK
#Enable echo support
ATE=1
OK

Note that +++ can also be used on the mobile device to send and receive AT command on
iOS or Android, though this should always be used with care.�

ATI
BLEFRIEND
nRF51822 QFAAG00
B122AAC33F3D2296
0.4.6
0.4.6
Dec 22 2014
OK
+++
OK
OK
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General Purpose
The following general purpose commands are available on all Bluefruit LE modules:

AT+FACTORYRESET
Clears any user config data from non-volatile memory and performs a factory reset before resetting
the Bluefruit module.

Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+DFU
Forces the module into DFU mode, allowing over the air firmware updates using a dedicated DFU
app on iOS or Android.

Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+FACTORYRESET
OK

As of version 0.5.0+ of the firmware, you can perform a factory reset by holding the DFU
button down for 10s until the blue CONNECTED LED lights up, and then releasing the button.�

The AT parser will no longer responsd after the AT+DFU command is entered, since normal
program execution effectively halts and a full system reset is performed to start the bootloader
code

�

AT+DFU
OK

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 92 of 170



 

AT+HELP
Displays a comma-separated list of all AT parser commands available on the system.

Codebase Version: 0.3.0

Parameters: None

Output: A comma-separated list of all AT parser commands available on the system.

The sample code below may not match future firmware releases and is provided for
illustration purposes only�

AT+HELP
AT+FACTORYRESET,AT+DFU,ATZ,ATI,ATE,AT+DBGMEMRD,AT+DBGNVMRD,AT+HWLEDPOLARITY,AT+
OK
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Hardware
The following commands allow you to interact with the low level HW on the Bluefruit LE module,
such as reading or toggling the GPIO pins, performing an ADC conversion ,etc.:

AT+HWADC
Performs an ADC conversion on the specified ADC pin

Codebase Revision: 0.3.0

Parameters: The ADC channel (0..7)

Output: The results of the ADC conversion

AT+HWGETDIETEMP
Gets the temperature in degree celcius of the BLE module's die.  This can be used for debug
purposes (higher die temperature generally means higher current consumption), but does not
corresponds to ambient temperature and can nto be used as a replacement for a normal
temperature sensor.

Codebase Revision: 0.3.0

Parameters: None

Output: The die temperature in degrees celcius

AT+HWGPIO
Gets or sets the value of the specified GPIO pin (depending on the pin's mode).

Codebase Revision: 0.3.0

AT+HWADC=0
178
OK

AT+HWGETDIETEMP
32.25
OK
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Parameters: The parameters for this command change depending on the pin mode.

OUTPUT MODE: The following comma-separated parameters can be used when updating a pin
that is set as an output:

Pin numbers
Pin state, where:

0 = clear the pin (logic low/GND)
1 = set the pin (logic high/VCC)

INPUT MODE: To read the current state of an input pin or a pin that has been configured as an
output, enter the pin number as a single parameter.

Output: The pin state if you are reading an input or checking the state of an input pin (meaning only
1 parameter is supplied, the pin number), where:

0 means the pin is logic low/GND
1 means the pin is logic high/VCC

Trying to set the value of a pin that has not been configured as an output will produce an
'ERROR' response.�

Some pins are reserved for specific functions on Bluefruit modules and can not be used as
GPIO. If you try to make use of a reserved pin number an 'ERROR' response will be
generated.

�
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AT+HWGPIOMODE
This will set the mode for the specified GPIO pin (input, output, etc.).

Codebase Revision: 0.3.0

Parameters: This command one or two values (comma-separated in the case of two parameters
being used):

The pin number
The new GPIO mode, where:

0 = Input
1 = Output
2 = Input with pullup enabled
3 = Input with pulldown enabled

Output: If a single parameters is passed (the GPIO pin number) the current pin mode will be
returned.

# Set pin 14 HIGH
AT+HWGPIO=14,1
OK
  
# Set pin 14 LOW
AT+HWGPIO=14,0
OK
  
# Read the current state of pin 14
AT+HWGPIO=14
0
OK
  
# Try to update a pin that is not set as an output
AT+HWGPIOMODE=14,0
OK
AT+HWGPIO=14,1
ERROR

Some pins are reserved for specific functions on Bluefruit modules and can not be used as
GPIO. If you try to make use of a reserved pin number an 'ERROR' response will be
generated.

�
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AT+HWI2CSCAN
Scans the I2C bus to try to detect any connected I2C devices, and returns the address of devices
that were found during the scan process.

Codebase Revision: 0.3.0

Parameters: None

Output: A comma-separated list of any I2C address that were found while scanning the valid
address range on the I2C bus, or nothing is no devices were found.

AT+HWVBAT
Returns the main power supply voltage level in millivolts

Codebase Revision: 0.3.0

Parameters: None

Output: The VBAT level in millivolts

# Configure pin 14 as an output
AT+HWGPIOMODE=14,0
OK

# Get the current mode for pin 14
AT+HWPGIOMODE=14
0
OK

# I2C scan with two devices detected
AT+HWI2CSCAN
0x23,0x35
OK

# I2C scan with no devices detected
AT+HWI2CSCAN
OK
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AT+HWRANDOM
Generates a random 32-bit number using the HW random number generator on the nRF51822
(based on white noise).

Codebase Revision: 0.4.7

Parameters: None

Output: A random 32-bit hexadecimal value (ex. '0x12345678')

AT+HWMODELED
Allows you to override the default behaviour of the MODE led (which indicates the operating mode
by default).

Codebase Revision: 0.6.6

Parameters: LED operating mode, which can be one of the following values:

disable or DISABLE or 0 - Disable the MODE LED entirely to save power
mode or MODE or 1 - Default behaviour, indicates the current operating mode
hwuart or HWUART or 2 - Toggles the LED on any activity on the HW UART bus (TX or RX)
bleuart or BLEUART or 3 - Toggles the LED on any activity on the BLE UART Service (TX or
RX characteristic)
spi or SPI or 4 - Toggles the LED on any SPI activity
manual or MANUAL or 5 - Manually sets the state of the MODE LED via a second comma-
separated parameter, which can be on, off, or toggle.

Output: If run with no parameters, returns an upper-case string representing the current MODE
LED operating mode from the fields above

AT+HWVBAT
3248
OK

AT+HWRANDOM
0x769ED823
OK
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# Get the curent MODE LED setting
AT+HWMODELED
MODE
OK
  
# Change the MODE LED to indicate BLE UART activity
AT+HWMODELED=BLEUART
OK

# Manually toggle the MODE LED
AT+HWMODELED=MANUAL,TOGGLE
OK
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Beacon
Adafruit's Bluefruit LE modules currently support the following 'Beacon' technologies:

Beacon (Apple) via AT+BLEBEACON
UriBeacon (Google) via AT+BLEURIBEACON (deprecated)
Eddystone (Google) via AT+EDDYSTONE*

Modules can be configured to act as 'Beacons' using the following commands:

AT+BLEBEACON
Codebase Revision: 0.3.0

Parameters: The following comma-separated parameters are required to enable beacon mode:

Bluetooth Manufacturer ID (uint16_t)
128-bit UUID
Major Value (uint16_t)
Minor Value (uint16_t)
RSSI @ 1m (int8_t)

Output: None

# Enable Apple iBeacon emulation
# Manufacturer ID = 0x004C
AT+BLEBEACON=0x004C,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK
# Reset to change the advertising data
ATZ
OK
  
# Enable Nordic Beacon emulation
# Manufacturer ID = 0x0059
AT+BLEBEACON=0x0059,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK
# Reset to change the advertising data
ATZ
OK

AT+BLEBEACON will cause the beacon data to be stored in non-volatile config memory on the
Bluefruit LE module, and these values will be persisted across system resets and power
cycles. To remove or clear the beacon data you need to enter the 'AT+FACTORYRESET'

�
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Entering Nordic Beacon emulation using the sample code above, you can see the simulated beacon
in Nordic's 'Beacon Config' tool below:

command in command mode.�
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AT+BLEURIBEACON
Converts the specified URI into a UriBeacon (http://adafru.it/edk) advertising packet, and configures
the module to advertise as a UriBeacon (part of Google's Physical
Web (http://adafru.it/ehZ) project).

To view the UriBeacon URIs you can use one of the following mobile applications:

Android 4.3+: Physical Web (http://adafru.it/edi) on the Google Play Store
iOS: Physical Web (http://adafru.it/edj) in Apple's App Store

Codebase Revision: 0.4.7

Parameters: The URI to encode (ex. http://www.adafruit.com/blog (http://adafru.it/ei0))

Output: None of a valid URI was entered (length is acceptable, etc.).

If the supplied URI is too long you will get the following output:

AT+BLEURIBEACON=http://www.adafruit.com/blog
OK

# Reset to change the advertising data
ATZ
OK
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AT+EDDYSTONEENABLE
This command will enable Eddystone (http://adafru.it/fSA) support on the Bluefruit LE module.
Eddystone support must be enabled before the other related commands can be used.

Codebase Revision: 0.6.6

Parameters: 1 or 0 (1 = enable, 0 = disable)

Output: The current state of Eddystone support if no parameters are provided (1 = enabled, 0 =
disabled)

AT+EDDYSTONEURL
This command will set the URL for the Eddystone-URL (http://adafru.it/fSB) protocol.

Codebase Revision: 0.6.6

Parameters: 

AT+BLEURIBEACON=http://www.adafruit.com/this/uri/is/too/long
URL is too long
ERROR

If the URI that you are trying to encode is too long, try using a shortening service like bit.ly,
and encode the shortened URI.�

UriBeacon should be considered deprecated as a standard, and EddyStone should be used
for any future development. No further development will happen in the Bluefruit LE firmware
around UriBeacon.

�

# Enable Eddystone support
AT+EDDYSTONEENABLE=1
OK

# Check the current Eddystone status on the module
AT+EDDYSTONEENABLE
1
OK
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The URL to encode (mandatory)
An optional second parameter indicates whether to continue advertising the Eddystone URL
even when the peripheral is connected to a central device
Firmware 0.6.7 added an optional third parameter for the RSSI at 0 meters value. This should
be measured by the end user by checking the RSSI value on the receiving device at 1m and
then adding 41 to that value (to compensate for the signal strength loss over 1m), so an RSSI
of -62 at 1m would mean that you should enter -21 as the RSSI at 0m.  Default value is -
18dBm.

Output: Firmware <= 0.6.6: none.  With firmware >= 0.6.7 running this command with no
parameters will return the current URL.

AT+EDDYSTONECONFIGEN
This command causes the Bluefruit LE module to enable the Eddystone URL config service for the
specified number of seconds.

This command should be used in combination with the Physical Web application from Google,
available for Android (http://adafru.it/edi) or iOS (http://adafru.it/edj).  Run this command then select
the 'Edit URL' option from the app to change the destination URL over the air.

Codebase Revision: 0.6.6

Parameters: The number of seconds to advertised the config service UUID

Output: None

# Set the Eddystone URL to adafruit
AT+EDDYSTONEURL=http://www.adafruit.com
OK
  
# Set the Eddystone URL to adafruit and advertise it even when connected
AT+EDDYSTONEURL=http://www.adafruit.com,1
OK

# Start advertising the Eddystone config service for 5 minutes (300s)
AT+EDDYSTONECONFIGEN=300
OK
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BLE Generic
The following general purpose BLE commands are available on Bluefruit LE modules:

AT+BLEPOWERLEVEL
Gets or sets the current transmit power level for the module's radio (higher transmit power equals
better range, lower transmit power equals better battery life).

Codebase Revision: 0.3.0

Parameters: The TX power level (in dBm), which can be one of the following values (from lowest to
higher transmit power):

-40
-20
-16
-12
-8
-4
0
4

Output: The current transmit power level (in dBm)

The updated power level will take affect as soon as the command is entered. If the device isn't
connected to another device, advertising will stop momentarily and then restart once the new
power level has taken affect.

�
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AT+BLEGETADDRTYPE
Gets the address type (for the 48-bit BLE device address).

Normally this will be '1' (random), which means that the module uses a 48-bit address that was
randomly generated during the manufacturing process and written to the die by the manufacturer.

Random does not mean that the device address is randomly generated every time, only that a one-
time random number is used.

Codebase Revision: 0.3.0

Parameters: None

Output: The address type, which can be one of the following values:

0 = public
1 = random

AT+BLEGETADDR
Gets the 48-bit BLE device address.

# Get the current TX power level (in dBm)
AT+BLEPOWERLEVEL
0
OK
  
# Set the TX power level to 4dBm (maximum value)
AT+BLEPOWERLEVEL=4
OK
  
# Set the TX power level to -12dBm (better battery life)
AT+BLEPOWERLEVEL=-12
OK
  
# Set the TX power level to an invalid value
AT+BLEPOWERLEVEL=-3
ERROR

AT+BLEGETADDRTYPE
1
OK
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Codebase Revision: 0.3.0

Parameters: None

Output: The 48-bit BLE device address in the following format: 'AA:BB:CC:DD:EE:FF'

AT+BLEGETPEERADDR
Gets the 48-bit address of the peer (central) device we are connected to.

Codebase Revision: 0.6.5

Parameters: None

Output: The 48-bit address of the connected central device in hex format. The command will
return ERROR if we are not connected to a central device.

AT+BLEGETRSSI
Gets the RSSI value (Received Signal Strength Indicator), which can be used to estimate the
reliability of data transmission between two devices (the lower the number the better).

Codebase Revision: 0.3.0

Parameters: None

Output: The RSSI level (in dBm) if we are connected to a device, otherwise '0'

AT+BLEGETADDR
E4:C6:C7:31:95:11
OK

Please note that the address returned by the central device is almost always a random value
that will change over time, and this value should generally not be trusted. This command is
provided for certain edge cases, but is not useful in most day to day scenarios.

�

AT+BLEGETPEERADDR
48:B2:26:E6:C1:1D
OK
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# Connected to an external device
AT+BLEGETRSSI
-46
OK
  
# Not connected to an external device
AT+BLEGETRSSI
0
OK
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BLE Services
The following commands allow you to interact with various GATT services present on Bluefruit LE
modules when running in Command Mode.

AT+BLEUARTTX
This command will transmit the specified text message out via the UART
Service (http://adafru.it/iCn) while you are running in Command Mode.

Codebase Revision: 0.3.0

Parameters: The message payload to transmit. The payload can be up to 240 characters (since AT
command strings are limited to a maximum of 256 bytes total).

Output: This command will produce an ERROR message if you are not connected to a central
device, or if the internal TX FIFO on the Bluefruit LE module is full.

As of firmware release 0.6.2 and higher, AT+BLEUARTTX can accept a limited set of escape code
sequences:

\r = carriage return
\n = new line
\t = tab
\b = backspace
\\ = backward slash

As of firmware release 0.6.7 and higher, AT+BLEUARTTX can accept the following escape code
sequence since AT+BLEUARTTX=? has a specific meaning to the AT parser:

\? = transmits a single question mark

You must be connected to another device for this command to execute�

# Send a string when connected to another device
AT+BLEUARTTX=THIS IS A TEST
OK
  
# Send a string when not connected
AT+BLEUARTTX=THIS IS A TEST
ERROR
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TX FIFO Buffer Handling

Starting with firmware version 0.6.7, when the TX FIFO buffer is full a 200ms blocking delay will be
used to see if any free space becomes available in the FIFO before returning ERROR. The
exact process is detailed in the flow chart below:

You can use the AT+BLEUARTFIFO=TX (http://adafru.it/id3) command to check the size of the TX
FIFO before sending data to ensure that you have enough free space available in the buffer.

The TX FIFO has the following size, depending on the firmware version used:

Firmware <=0.6.6: 160 characters wide
Firmware >=0.6.7: 1024 characters wide

Note: The TX FIFO full check will happen for each GATT transaction (of up to 20 bytes of data
each), so large data transfers may have multiple 200ms wait states.�
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AT+BLEUARTRX
This command will dump the UART service (http://adafru.it/iCn)'s RX buffer to the display if any data
has been received from from the UART service while running in Command Mode. The data will be
removed from the buffer once it is displayed using this command.

Any characters left in the buffer when switching back to Data Mode will cause the buffered
characters to be displayed as soon as the mode switch is complete (within the limits of available
buffer space, which is 1024 bytes on current black 32KB SRAM devices, or 160 bytes for the blue
first generation BLEFriend board based on 16KB SRAM parts).

Codebase Revision: 0.3.0

Parameters: None

Output: The RX buffer's content if any data is available, otherwise nothing.

AT+BLEUARTFIFO

It IS possible with large data transfers that part of the payload can be transmitted, and the
command can still produce an ERROR if the FIFO doesn't empty in time in the middle of the
payload transfer (since data is transmitted in maximum 20 byte chunks). If you need to ensure
reliable data transfer, you should always check the TX FIFO size before sending data, which
you can do using the AT+BLEUARTFIFO command. If not enough space is available for the
entire payload, add a SW delay until enough space is available. Any single AT+BLEUARTTX
command can fit into the FIFO, but multiple large instances of this command may cause the
FIFO to fill up mid transfer.

�

You can also use the AT+BLEUARTFIFO=RX command to check if any incoming data is
available or not.�

# Command results when data is available
AT+BLEUARTRX
Sent from Android
OK
  
# Command results when no data is available
AT+BLEUARTRX
OK
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This command will return the free space available in the BLE UART TX and RX FIFOs.  If you are
transmitting large chunks of data, you may want to check if you have enough free space in the TX
FIFO before sending, keeping in mind that individual GATT packets can contain up to 20 user bytes
each.

Codebase Revision: 0.6.7

Parameters: Running this command with no parameters will return two comma-separated values
indicating the free space in the TX buffer, following by the RX buffer.  To request a specific buffer,
you can execute the command with either a "TX" or "RX" value (For example:
"AT+BLEUARTFIFO=TX").

Output: The free space remaining in the TX and RX FIFO buffer if no parameter is present,
otherwise the free space remaining in the specified FIFO buffer.

AT+BLEKEYBOARDEN
This command will enable GATT over HID (GoH) keyboard support, which allows you to emulate a
keyboard on supported iOS and Android devices.  By default HID keyboard support is disabled, so
you need to set BLEKEYBOARDEN to 1 and then perform a system reset before the keyboard will
be enumerated and appear in the Bluetooth preferences on your phone, where if can be bonded as
a BLE keyboard.

Codebase Revision: 0.5.0

Parameters: 1 or 0 (1 = enable, 0 = disable)

Output: None

AT+BLEUARTFIFO
1024,1024
OK

AT+BLEUARTFIFO=TX
1024
OK

AT+BLEUARTFIFO=RX
1024
OK

As of firmware version 0.6.6 this command is now an alias for AT+BLEHIDEN
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AT+BLEKEYBOARD
Sends text data over the BLE keyboard interface (if it has previously been enabled via
AT+BLEKEYBOARDEN).

Any valid alpha-numeric character can be sent, and the following escape sequences are also
supported:

\r - Carriage Return
\n - Line Feed
\b - Backspace
\t - Tab
\\ - Backslash

As of version 0.6.7 you can also use the following escape code when sending a single character
('AT+BLEKEYBOARD=?' has another meaning for the AT parser):

\? - Question mark

Codebase Revision: 0.5.0

Parameters: The text string (optionally including escape characters) to transmit

�
You must perform a system reset (ATZ) before the changes take effect!�

Before you can use your HID over GATT keyboard, you will need to bond your mobile device
with the Bluefruit LE module in the Bluetooth preferences panel.�

# Enable BLE keyboard support then reset
AT+BLEKEYBOARDEN=1
OK
ATZ
OK
  
# Disable BLE keyboard support then reset
AT+BLEKEYBOARDEN=0
OK
ATZ
OK
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Output: None

AT+BLEKEYBOARDCODE
Sends a raw hex sequence of USB HID keycodes to the BLE keyboard interface including key
modifiers and up to six alpha-numeric characters.

This command accepts the following ascii-encoded HEX payload, matching the way HID over GATT
sends keyboard data:

Byte 0: Modifier
Byte 1: Reserved (should always be 00)
Bytes 2..7: Hexadecimal values for ASCII-encoded characters (if no character is used you
can enter '00' or leave trailing characters empty)

After a keycode sequence is sent with the AT+BLEKEYBOARDCODE command, you must send a
second AT+BLEKEYBOARDCODE command with at least two 00 characters to indicate the
keys were released!

Modifier Values

The modifier byte can have one or more of the following bits set:

Bit 0 (0x01): Left Control
Bit 1 (0x02): Left Shift
Bit 2 (0x04): Left Alt
Bit 3 (0x08): Left Window
Bit 4 (0x10): Right Control
Bit 5 (0x20): Right Shift
Bit 6 (0x40): Right Alt
Bit 7 (0x80): Right Window

Codebase Revision: 0.5.0

# Send a URI with a new line ending to execute in Chrome, etc.
AT+BLEKEYBOARD=http://www.adafruit.com\r\n
OK
  
# Send a single question mark (special use case, 0.6.7+)
AT+BLEKEYBOARD=\?
OK
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Parameters: A set of hexadecimal values separated by a hyphen ('-').  Note that these are HID scan
code values, not standard ASCII values!

Output: None

A list of HID keyboard codes can be found here (http://adafru.it/cQV) (see section 7).

AT+BLEHIDEN
This command will enable GATT over HID (GoH) support, which allows you to emulate a keyboard,
mouse or media controll on supported iOS, Android, OSX and Windows 10 devices.  By default HID
support is disabled, so you need to set BLEHIDEN to 1 and then perform a system reset before the
HID devices will be enumerated and appear in on your central device.

Codebase Revision: 0.6.6

Parameters: 1 or 0 (1 = enable, 0 = disable)

Output: None

HID key code values don't correspond to ASCII key codes! For example, 'a' has an HID
keycode value of '04', and there is no keycode for an upper case 'A' since you use the
modifier to set upper case values. For details, google 'usb hid keyboard scan codes', and see
the example below.

�

# send 'abc' with shift key --> 'ABC'
AT+BLEKEYBOARDCODE=01-00-04-05-06-00-00
OK
# Indicate that the keys were released (mandatory!)
AT+BLEKEYBOARDCODE=00-00
OK

You normally need to 'bond' the Bluefruit LE peripheral to use the HID commands, and the
exact bonding process will change from one operating system to another.�

If you have previously bonded to a device and need to clear the bond, you can run the
AT+FACTORYRESET command which will erase all stored bond data on the Bluefruit LE
module.

�
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AT+BLEHIDMOUSEMOVE
Moves the HID mouse or scroll wheen position the specified number of ticks.

All parameters are signed 8-bit values (-128 to +127).  Positive values move to the right or down,
and origin is the top left corner.

Codebase Revision: 0.6.6

Parameters: X Ticks (+/-), Y Ticks (+/-), Scroll Wheel (+/-), Pan Wheel (+/-)

Output: None

AT+BLEHIDMOUSEBUTTON
Manipulates the HID mouse buttons via the specific string(s).

Codebase Revision: 0.6.6

Parameters: Button Mask String [L][R][M][B][F], Action [PRESS][CLICK][DOUBLECLICK][HOLD]

L = Left Button
R = Right Button
M = Middle Button

# Enable GATT over HID support on the Bluefruit LE module
AT+BLEHIDEN=1
OK
  
# Reset so that the changes take effect
ATZ
OK

# Move the mouse 100 ticks right and 100 ticks down
AT+BLEHIDMOUSEMOVE=100,100
OK
  
# Scroll down 20 pixels or lines (depending on context)
AT+BLEHIDMOUSEMOVE=,,20,
OK
  
# Pan (horizontal scroll) to the right (exact behaviour depends on OS)
AT+BLEHIDMOUSEMOVE=0,0,0,100
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B = Back Button
F = Forward Button
If the second parameter (Action) is "HOLD", an optional third parameter can be passed
specifying how long the button should be held in milliseconds.

Output: None

AT+BLEHIDCONTROLKEY
Sends HID media control commands for the bonded device (adjust volume, screen brightness, song
selection, etc.).

Codebase Revision: 0.6.6

Parameters: The HID control key to send, followed by an optional delay in ms to hold the button

The control key string can be one of the following values:

System Controls (works on most systems)

BRIGHTNESS+
BRIGHTNESS-

Media Controls (works on most systems)

PLAYPAUSE
MEDIANEXT
MEDIAPREVIOUS

# Double click the left mouse button
AT+BLEHIDMOUSEBUTTON=L,doubleclick
OK

# Press the left mouse button down, move the mouse, then release L
# This is required to perform 'drag' then stop type operations
AT+BLEHIDMOUSEBUTTON=L
OK
AT+BLEHIDMOUSEMOVE=-100,50
OK
AT+BLEHIDMOUSEBUTTON=0
OK
  
# Hold the backward mouse button for 200 milliseconds (OS dependent)
AT+BLEHIDMOUSEBUTTON=B,hold,200
OK

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 117 of 170



MEDIASTOP

Sound Controls (works on most systems)

VOLUME
MUTE
BASS
TREBLE
BASS_BOOST
VOLUME+
VOLUME-
BASS+
BASS-
TREBLE+
TREBLE-

Application Launchers (Windows 10 only so far)

EMAILREADER
CALCULATOR
FILEBROWSER

Browser/File Explorer Controls (Firefox on Windows/Android only)

SEARCH
HOME
BACK
FORWARD
STOP
REFRESH
BOOKMARKS

You can also send a raw 16-bit hexadecimal value in the '0xABCD' format. A full list of 16-bit 'HID
Consumer Control Key Codes' can be found here  (http://adafru.it/cQV)(see section 12).

Output: Normally none.

If you are not bonded and connected to a central device, this command will return ERROR.
Make sure you are connected and HID support is enabled before running these commands.�
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# Toggle the sound on the bonded central device
AT+BLEHIDCONTROLKEY=MUTE
OK

# Hold the VOLUME+ key for 500ms
AT+BLEHIDCONTROLKEY=VOLUME+,500
OK

# Send a raw 16-bit Consumer Key Code (0x006F = Brightness+)
AT+BLEHIDCONTROLKEY=0x006F
OK
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BLE GAP
GAP (http://adafru.it/iCo), which stands for the Generic Access Profile, governs advertising and
connections with Bluetooth Low Energy devices.

The following commands can be used to configure the GAP settings on the BLE module.

You can use these commands to modify the advertising data (for ex. the device name that appears
during the advertising process), to retrieve information about the connection that has been
established between two devices, or the disconnect if you no longer wish to maintain a connection.

AT+GAPGETCONN
Diplays the current connection status (if we are connected to another BLE device or not).

Codebase Revision: 0.3.0

Parameters: None

Output: 1 if we are connected, otherwise 0

AT+GAPDISCONNECT
Disconnects to the external device if we are currently connected.

Codebase Revision: 0.3.0

Parameters: None

Output: None

# Connected
AT+GAPGETCONN
1
OK
  
# Not connected
AT+GAPGETCONN
0
OK
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AT+GAPDEVNAME
Gets or sets the device name, which is included in the advertising payload for the Bluefruit LE
module

Codebase Revision: 0.3.0

Parameters:

None to read the current device name
The new device name if you want to change the value

Output: The device name if the command is executed in read mode

AT+GAPDELBONDS
Deletes and bonding information stored on the Bluefruit LE module.

Codebase Revision: 0.3.0

Parameters: None

AT+GAPDISCONNECT
OK

Updating the device name will persist the new value to non-volatile memory, and the updated
name will be used when the device is reset. To reset the device to factory settings and clean
the config data from memory run the AT+FACTORYRESET command.

�

# Read the current device name
AT+GAPDEVNAME
UART
OK
  
# Update the device name to 'BLEFriend'
AT+GAPDEVNAME=BLEFriend
OK
# Reset to take effect
ATZ
OK
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Output: None

AT+GAPINTERVALS
Gets or sets the various advertising and connection intervals for the Bluefruit LE module.

Be extremely careful with this command since it can be easy to cause problems changing the
intervals, and depending on the values selected some mobile devices may no longer recognize the
module or refuse to connect to it.

Codebase Revision: 0.3.0

Parameters: If updating the GAP intervals, the following comma-separated values can be entered:

Minimum connection interval (in milliseconds)
Maximum connection interval (in milliseconds)
Advertising interval (in milliseconds)
Advertising timeout (in milliseconds)

Output: If reading the current GAP interval settings, the following comma-separated information will
be displayed:

Minimum connection interval (in milliseconds)
Maximum connection interval (in milliseconds)
Advertising interval (in milliseconds)
Advertising timeout (in milliseconds)

AT+GAPDELBONDS
OK

If you only wish to update one interval value, leave the other comma-separated values empty
(ex. ',,110,' will only update the third value, advertising interval).�

Updating the GAP intervals will persist the new values to non-volatile memory, and the
updated values will be used when the device is reset. To reset the device to factory settings
and clean the config data from memory run the AT+FACTORYRESET command.

�
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AT+GAPSTARTADV
Causes the Bluefruit LE module to start transmitting advertising packets if this isn't already the case
(assuming we aren't already connected to an external device).

Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+GAPSTOPADV
Stops advertising packets from being transmitted by the Bluefruit LE module.

Codebase Revision: 0.3.0

Parameters: None

# Read the current GAP intervals
AT+GAPINTERVALS
20,100,100,30
  
# Update all values
AT+GAPINTERVALS=20,200,200,30
OK
  
# Update only the advertising interval
AT+GAPINTERVALS=,,150,
OK

# Command results when advertising data is not being sent
AT+GAPSTARTADV
OK
  
# Command results when we are already advertising
AT+GAPSTARTADV
ERROR
  
# Command results when we are connected to another device
AT+GAPSTARTADV
ERROR
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Output: None

AT+GAPSETADVDATA
Sets the raw advertising data payload to the specified byte array (overriding the normal advertising
data), following the guidelines in the Bluetooth 4.0 or 4.1 Core Specification (http://adafru.it/ddd).

In particular, Core Specification Supplement (CSS) v4 contains the details on common
advertising data fields like 'Flags' (Part A, Section 1.3) and the various Service UUID lists (Part A,
Section 1.1). A list of all possible GAP Data Types is available on the Bluetooth SIG's Generic
Access Profile (http://adafru.it/cYs) page.

The Advertising Data payload consists of Generic Access Profile (http://adafru.it/cYs) data that is
inserted into the advertising packet in the following format: [U8:LEN] [U8:Data Type Value] [n:Value]

For example, to insert the 'Flags' Data Type (Data Type Value 0x01), and set the value to
0x06/0b00000110 (BR/EDR Not Supported and LE General Discoverable Mode) we would use the
following byte array:

0x02 indicates the number of bytes in the entry

AT+GAPSTOPADV
OK

WARNING: This command requires a degree of knowledge about the low level details of the
Bluetooth 4.0 or 4.1 Core Specification, and should only be used by expert users. Misuse of
this command can easily cause your device to be undetectable by central devices in radio
range.

�

WARNING: This command will override the normal advertising payload and may prevent
some services from acting as expected.�

To restore the advertising data to the normal default values use the AT+FACTORYRESET
command.�

02-01-06
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0x02 indicates the number of bytes in the entry
0x01 is the 'Data Type Value (http://adafru.it/cYs)' and indicates that this is a 'Flag'
0x06 (0b00000110) is the Flag value, and asserts the following fields (see Core Specification
4.0, Volume 3, Part C, 18.1):

LE General Discoverable Mode (i.e. anyone can discover this device)
BR/EDR Not Supported (i.e. this is a Bluetooth Low Energy only device)

If we also want to include two 16-bit service UUIDs in the advertising data (so that listening devices
know that we support these services) we could append the following data to the byte array:

0x05 indicates that the number of bytes in the entry (5)
0x02 is the 'Data Type Value (http://adafru.it/cYs)' and indicates that this is an 'Incomplete
List of 16-bit Service Class UUIDs'
0x0D 0x18 is the first 16-bit UUID (which translates to 0x180D, corresponding to the Heart
Rate Service (http://adafru.it/ddB)).
0x0A 0x18 is another 16-bit UUID (which translates to 0x180A, corresponding to the Device
Information Service (http://adafru.it/ecj)).

Codebase Revision: 0.3.0

Parameters: The raw byte array that should be inserted into the advertising data section of the
advertising packet, being careful to stay within the space limits defined by the Bluetooth Core
Specification.

Response: None

The results of this command can be seen in the screenshot below, taken from a sniffer analyzing
the advertising packets in Wireshark. The advertising data payload is higlighted in blue in the raw

05-02-0D-18-0A-18

Including the service UUIDs is important since some mobile applications will only work with
devices that advertise a specific service UUID in the advertising packet. This is true for most
apps from Nordic Semiconductors, for example.

�

# Advertise as Discoverable and BLE only with 16-bit UUIDs 0x180D and 0x180A
AT+GAPSETADVDATA=02-01-06-05-02-0d-18-0a-18
OK
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byte array at the bottom of the image, and the packet analysis is in the upper section:
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BLE GATT
GATT (http://adafru.it/iCp), which standards for the Generic ATTribute Profile, governs data
organization and data exchanges between connected devices.  One device (the peripheral) acts as
a GATT Server, which stores data in Attribute records, and the second device in the connection (the
central) acts as a GATT Client, requesting data from the server whenever necessary.

The following commands can be used to create custom GATT services and characteristics on the
BLEFriend, which are used to store and exchange data.

Please note that any characteristics that you define here will automatically be saved to non-volatile
FLASH config memory on the device and re-initialised the next time the device starts.  You need to
perform a system reset before most of the commands below will take effect!

If you want to clear any previous config value, enter the 'AT+FACTORYRESET' command before
working on a new peripheral configuration.

AT+GATTCLEAR
Clears any custom GATT services and characteristics that have been defined on the device.

Codebase Revision: 0.3.0

Parameters: None

Response: None

AT+GATTADDSERVICE
Adds a new custom service definition to the device.

Codebase Revision: 0.3.0

Parameters: This command accepts a set of comma-separated key-value pairs that are used to
define the service properties.  The following key-value pairs can be used:

UUID: The 16-bit UUID to use for this service.  16-bit values should be in hexadecimal format
(0x1234).
UUID128: The 128-bit UUID to use for this service.  128-bit values should be in the following
format: 00-11-22-33-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF 

AT+GATTCLEAR
OK

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 127 of 170

../../../../introduction-to-bluetooth-low-energy/gatt


Response: The index value of the service in the custom GATT service lookup table. (It's important
to keep track of these index values to work with the service later.)

AT+GATTADDCHAR
Adds a custom characteristic to the last service that was added to the peripheral (via
AT+GATTADDSERVICE).

Note: Key values are not case-sensitive�

Only one UUID type can be entered for the service (either UUID or UUID128)�

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F
1
OK
  
# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1
OK

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1
OK

# Add a custom characteristic to the above service (making sure that there
# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
1
OK
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Codebase Revision: 0.3.0

Parameters: This command accepts a set of comma-separated key-value pairs that are used to
define the characteristic properties.  The following key-value pais can be used:

UUID: The 16-bit UUID to use for the characteristic (which will be insert in the 3rd and 4th
bytes of the parent services 128-bit UUID). This value should be entered in hexadecimal
format (ex. 'UUID=0x1234'). This value must be unique, and should not conflict with bytes 3+4
of the parent service's 128-bit UUID.
PROPERTIES: The 8-bit characteristic properties field, as defined by the Bluetooth SIG. The
following values can be used:

0x02 - Read
0x04 - Write Without Response
0x08 - Write
0x10 - Notify
0x20 - Indicate

MIN_LEN: The minimum size of the values for this characteristic (in bytes, min = 1, max = 20,
default = 1)
MAX_LEN: The maximum size of the values for the characteristic (in bytes, min = 1, max =
20, default = 1)
VALUE: The initial value to assign to this characteristic (within the limits of 'MIN_LEN' and
'MAX_LEN'). Value can be an integer ("-100", "27"), a hexadecimal value ("0xABCD"), a byte
array ("aa-bb-cc-dd") or a string ("GATT!").

Response: The index value of the characteristic in the custom GATT characteristic lookup table.
(It's important to keep track of these characteristic index values to work with the characteristic later.)

AT+GATTADDCHAR must be run AFTER AT+GATTADDSERVICE, and will add the new
characteristic to the last service definition that was added.�

As of version 0.6.6 of the Bluefruit LE firmware you can now use custom 128-bit UUIDs with
this command. See the example at the bottom of this command description.�

Note: Key values are not case-sensitive�

Make sure that the 16-bit UUID is unique and does not conflict with bytes 3+4 of the 128-bit
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Version 0.6.6 of the Bluefruit LE firmware added the ability to use a new 'UUID128' flag to add
custom 128-bit UUIDs that aren't related to the parent service UUID (which is used when passing
the 16-bit 'UUID' flag).

To specify a 128-bit UUID for your customer characteristic, enter a value resembling the following
syntax:

service UUID
�
# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F
1
OK
  
# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1
OK

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1
OK

# Add a custom characteristic to the above service (making sure that there
# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
1
OK
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AT+GATTCHAR
Gets or sets the value of the specified custom GATT characteristic (based on the index ID returned
when the characteristic was added to the system via AT+GATTADDCHAR).

Codebase Revision: 0.3.0

Parameters: This function takes one or two comma-separated functions (one parameter = read, two
parameters = write).

The first parameter is the characteristic index value, as returned from the
AT+GATTADDCHAR function. This parameter is always required, and if no second parameter
is entered the current value of this characteristic will be returned.
The second (optional) parameter is the new value to assign to this characteristic (within the
MIN_SIZE and MAX_SIZE limits defined when creating it).

Response: If the command is used in read mode (only the characteristic index is provided as a
value), the response will display the current value of the characteristics.  If the command is used in
write mode (two comma-separated values are provided), the characteristics will be updated to use
the provided value.

# Add a custom characteristic to the above service using a
# custom 128-bit UUID
AT+GATTADDCHAR=UUID128=00-11-22-33-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF,PROPERTIES=0x02,MIN_LEN
1
OK
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AT+GATTLIST
Lists all custom GATT services and characteristics that have been defined on the device.

Codebase Revision: 0.3.0

Parameters: None

Response: A list of all custom services and characteristics defined on the device.

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F
1
OK
  
# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1
OK

# Read the battery measurement characteristic (index ID = 1)
AT+GATTCHAR=1
0x64
OK

# Update the battery measurement characteristic to 32 (hex 0x20)
AT+GATTCHAR=1,32
OK

# Verify the previous write attempt
AT+GATTCHAR=1
0x20
OK
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# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F
1
OK
  
# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1
OK
  
# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
2
OK

# Add a custom characteristic to the above service (making sure that there
# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
2
OK

# Get a list of all custom GATT services and characteristics on the device
AT+GATTLIST
ID=01,UUID=0x180F
  ID=01,UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,MAX_LEN=1,VALUE=0x64
ID=02,UUID=0x11, UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
  ID=02,UUID=0x02,PROPERTIES=0x02,MIN_LEN=1,MAX_LEN=1,VALUE=0x64
OK
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Debug
The following debug commands are available on Bluefruit LE modules:

AT+DBGMEMRD
Displays the raw memory contents at the specified address.

Codebase Revision: 0.3.0

Parameters: The following comma-separated parameters can be used with this command:

The starting address to read memory from (in hexadecimal form, with or without the leading
'0x')
The word size (can be 1, 2, 4 or 8)
The number of words to read

Output: The raw memory contents in hexadecimal format using the specified length and word size
(see examples below for details)

AT+DBGNVMREAD

Use these commands with care since they can easily lead to a HardFault error on the ARM
core, which will cause the device to stop responding.�

# Read 12 1-byte values starting at 0x10000009
AT+DBGMEMRD=0x10000009,1,12
FF FF FF FF FF FF FF 00 04 00 00 00
OK

# Try to read 2 4-byte values starting at 0x10000000
AT+DBGMEMRD=0x10000000,4,2
55AA55AA 55AA55AA
OK  
  
# Try to read 2 4-byte values starting at 0x10000009
# This will fail because the Cortex M0 can't perform misaligned
# reads, and any non 8-bit values must start on an even address
AT+DBGMEMRD=0x10000009,4,2
MISALIGNED ACCESS
ERROR
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Displays the raw contents of the config data section of non-volatile memory

Codebase Revision: 0.3.0

Properties: None

Output: The raw config data from non-volatile memory

AT+DBGSTACKSIZE
Returns the current stack size, to help detect stack overflow or detect stack memory usage when
optimising memory usage on the system.

Codebase Revision: 0.4.7

Parameters: None

Output: The current size of stack memory in bytes

AT+DBGSTACKDUMP
Dumps the current stack contents. Unused sections of stack memory are filled with '0xCAFEFOOD'
to help determine where stack usage stops.

This command is purely for debug and development purposes.

Codebase Revision: 0.4.7

Parameters: None

Output: The memory contents of the entire stack region

AT+DBGNVMRD
FE CA 38 05 00 03 00 00 01 12 01 00 55 41 52 54 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
OK

AT+DBGSTACKSIZE
1032
OK

AT+DBGSTACKDUMP
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AT+DBGSTACKDUMP
0x20003800: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003810: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003820: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003830: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003840: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003850: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003860: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003870: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003880: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003890: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038A0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038B0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038C0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038D0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038E0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200038F0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003900: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003910: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003920: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003930: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003940: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003950: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003960: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003970: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003980: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003990: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039A0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039B0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039C0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039D0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039E0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x200039F0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A00: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A10: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A20: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A30: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A40: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A50: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A60: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A70: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A80: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003A90: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AA0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AB0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AC0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AD0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AE0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
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0x20003AE0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003AF0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B00: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B10: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B20: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B30: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B40: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B50: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B60: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B70: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B80: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003B90: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BA0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BB0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BC0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BD0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BE0: CAFEF00D CAFEF00D CAFEF00D CAFEF00D
0x20003BF0: CAFEF00D CAFEF00D 00000000 CAFEF00D
0x20003C00: 00000004 20001D04 CAFEF00D FFFFEF68
0x20003C10: CAFEF00D 00001098 CAFEF00D CAFEF00D
0x20003C20: CAFEF00D CAFEF00D 00001006 200018D8
0x20003C30: 00000001 200018D8 20001C50 00000004
0x20003C40: 20001BB0 000134A5 0000100D 20001D28
0x20003C50: 00000006 00000006 20001C38 20001D44
0x20003C60: 20001C6C 20001D44 00000006 00000005
0x20003C70: 20001D38 00000005 20001D38 00000000
0x20003C80: 00000001 00012083 200018C8 000013D3
0x20003C90: 00550000 00000001 80E80000 4FC40000
0x20003CA0: 000080E8 00000009 60900000 000080E8
0x20003CB0: 60140000 20002764 0009608F 000080E8
0x20003CC0: 80000000 000080E8 00000000 00129F5F
0x20003CD0: 00000000 0001E4D9 80E80000 200018C8
0x20003CE0: 200018D4 00000000 80E80000 000000FF
0x20003CF0: 0000011C 0001BCE1 0000203A 0001BC1D
0x20003D00: 00000000 0001BC1D 80E80000 0001BCE1
0x20003D10: 0000011C 0001BDA9 80E80000 0001BDA9
0x20003D20: 0000011C FFFFFFF9 008B8000 0001BC1D
0x20003D30: 00000048 00000010 0000A000 00000009
0x20003D40: 0001E326 00000001 80E80000 51538000
0x20003D50: 000080E8 0001E9CF 00000000 00000009
0x20003D60: 61C78000 000080E8 00000048 00000504
0x20003D70: 0000A1FC 0002125C 00000000 000080E8
0x20003D80: 00000000 0012A236 00000000 0001E4D9
0x20003D90: 000080E8 00000009 00004998 000080E8
0x20003DA0: 622C8000 0012A29B 00000042 0001E479
0x20003DB0: 40011000 000185EF 00006E10 00000000
0x20003DC0: 00000000 00000004 0000000C 00000000
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0x20003DD0: 62780000 00018579 2000311B 0001ACDF
0x20003DE0: 00000000 20003054 20002050 00000001
0x20003DF0: 20003DF8 0002085D 00000001 200030D4
0x20003E00: 00000200 0001F663 00000001 200030D4
0x20003E10: 00000001 2000311B 0001F631 00020A6D
0x20003E20: 00000001 00000000 0000000C 200030D4
0x20003E30: 2000311B 00000042 200030D4 00020AD7
0x20003E40: 20002050 200030D4 20002050 00020833
0x20003E50: 20002050 20003F1B 20002050 0001FF89
0x20003E60: 20002050 0001FFA3 00000005 20003ED8
0x20003E70: 20002050 0001FF8B 00000010 00020491
0x20003E80: 00000001 0012A54E 00000020 00022409
0x20003E90: 00000000 20002050 200030D4 0001FF8B
0x20003EA0: 00021263 00000005 0000000C 20003F74
0x20003EB0: 20003ED8 20002050 200030D4 00020187
0x20003EC0: 20003ED4 20003054 00000000 20003F75
0x20003ED0: 00000008 20003F64 00000084 FFFFFFFF
0x20003EE0: FFFFFFFF 00000008 00000001 00000008
0x20003EF0: 20302058 2000311B 0001F631 00020A6D
0x20003F00: 20002050 00000000 0000000C 200030D4
0x20003F10: 32002050 32303032 00323330 000258D7
0x20003F20: 20002050 200030D4 20002050 00020833
0x20003F30: 00000000 20002050 00000020 000001CE
0x20003F40: 20003F40 200030D4 00000004 0001ED83
0x20003F50: 200030D4 20003F60 000001D6 000001D7
0x20003F60: 000001D8 00016559 0000000C 00000000
0x20003F70: 6C383025 00000058 200030D4 FFFFFFFF
0x20003F80: 1FFF4000 00000028 00000028 000217F8
0x20003F90: 200020C7 000166C5 000166AD 00017ED9
0x20003FA0: FFFFFFFF 200020B8 2000306C 200030D4
0x20003FB0: 200020B4 000180AD 1FFF4000 200020B0
0x20003FC0: 200020B0 200020B0 1FFF4000 0001A63D
0x20003FD0: CAFEF00D CAFEF00D 200020B4 00000002
0x20003FE0: FFFFFFFF FFFFFFFF 1FFF4000 00000000
0x20003FF0: 00000000 00000000 00000000 00016113
OK
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History
This page tracks additions or changes to the AT command set based on the firmware version
number (which you can obtain via the 'ATI' command):

Version 0.6.7
The following AT commands were added in the 0.6.7 release:

AT+BLEUARTFIFO
Returns the number of free bytes available in the TX and RX FIFOs for the Bluetooth UART
Service.

The following commands were changed in the 0.6.7 release:

AT+BLEUARTTX
If the TX FIFO is full, the command will wait up to 200ms to see if the FIFO size decreases
before exiting and returning an ERROR response due to the FIFO being full.
AT+BLEURIBEACON
This command will go back to using the old (deprecated) UriBeacon UUID (0xFED8), and only
the AT+EDDYSTONEURL command will use the newer Eddystone UUID (0xFEAA).
AT+BLEKEYBOARD and AT+BLEUARTTX
These commands now accept '\?' as an escape code since 'AT+BLEKEYBOARD=?' has
another meaning for the AT parser. To send a single question mark the following command
should be used: 'AT+BLEKEYBOARD=\?' or 'AT+BLEUARTTX=\?'
AT+EDDYSTONEURL
This command now accepts an optional third parameter for RSSI at 0m value (default is -
18dBm). 
Running this command with no parameters ('AT+EDDYSTONEURL\r\n') will now return the
current URL.

Key bug fixes in this release:

The FIFO handling for the Bluetooth UART Service was improved for speed and stability, and
the TX and RF FIFOs were increased to 1024 bytes each.
An issue where a timer overflow was causing factory resets every 4 hours or so has been
resolved.
Fixed a problem with the GATT server where 'value_len' was being incorrectly parsed for
integer values in characteristics where 'max_len' >4

Version 0.6.6
The following AT commands were added in the 0.6.6 release:
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AT+EDDYSTONEURL
Update the URL for the beacon and switch to beacon mode
AT+EDDYSTONEENABLE
Enable/disable beacon mode using the configured url
AT+EDDYSTONECONFIGEN
Enable advertising for the the Eddystone configuration service for the specified number of
seconds
AT+HWMODELED
Allows the user to override the default MODE LED behaviour with one of the following options:
DISABLE, MODE, HWUART, BLEUART, SPI, MANUAL
AT+BLECONTROLKEY
Allows HID media control values to be sent to a bonded central device (volume, screen
brightness, etc.)
AT+BLEHIDEN
Enables or disables BLE HID support in the Bluefruit LE firmware (mouse, keyboard and
media control)
AT+BLEMOUSEMOVE
To move the HID mouse
AT+BLEMOUSEBUTTON
To set the state of the HID mouse buttons

The following commands were changed in the 0.6.6 release:

AT+BLEKEYBOARDEN - Now an alias for AT+BLEHIDEN
AT+GATTADDCHAR - Added a new UUID128 field to allow custom UUIDs

Key bug fixes in this release:

Fixed issues with long beacon URLs
Fixed big endian issue in at+blebeacon for major & minor number

Known issues with this release:

Windows 10 seems to support a limited number of characteristics for the DIS service. We had
to disable the Serial Number characteristic to enable HID support with windows 10.

Version 0.6.5
The following AT commands were added in the 0.6.5 release:

AT+BLEGETPEERADDR (http://adafru.it/iCq)

The following commands were changed in the 0.6.5 release:
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Increased the UART buffer size (on the nRF51) from 128 to 256 bytes
+++ now responds with the current operating mode
Fixed a bug with AT+GATTCHAR values sometimes not being saved to NVM
Fixed a bug with AT+GATTCHAR max_len value not being taken into account after a reset
(min_len was always used when repopulating the value)

Version 0.6.2
This is the first release targetting 32KB SRAM parts (QFAC). 16KB SRAM parts can't be used with
this firmware due to memory management issues, and should use the earlier 0.5.0 firmware.

The following AT commands were changed in the 0.6.2 release:

AT+BLEUARTTX (http://adafru.it/iCr)
Basic escape codes were added for new lines, tabs and backspace
AT+BLEKEYBOARD (http://adafru.it/iCr)
Also works with OS X now, and may function with other operating systems that support BLE
HID keyboards

Version 0.5.0
The following AT commands were added in the 0.5.0 release:

AT+BLEKEYBOARDEN (http://adafru.it/iCr)
AT+BLEKEYBOARD (http://adafru.it/iCr)
AT+BLEKEYBOARDCODE (http://adafru.it/iCr)

The following AT commands were changed in the 0.5.0 release:

ATI (http://adafru.it/iCs)
The SoftDevice, SoftDevice version and bootloader version were added as a new (7th)
record. For Ex: "S110 7.1.0, 0.0" indicates version 7.1.0 of the S110 softdevice is used with
the 0.0 bootloader (future boards will use a newer 0.1 bootloader).

Other notes concerning 0.5.0:

Starting with version 0.5.0, you can execute the AT+FACTORYRESET command at any point (and
without a terminal emulator) by holding the DFU button down for 10 seconds until the blue
CONNECTED LED starts flashing, then releasing it.

Version 0.4.7
The following AT commands were added in the 0.4.7 release:
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+++ (http://adafru.it/iCs)
AT+HWRANDOM (http://adafru.it/iCt)
AT+BLEURIBEACON (http://adafru.it/iCu)
AT+DBGSTACKSIZE (http://adafru.it/iCv)
AT+DBGSTACKDUMP (http://adafru.it/iCv)

The following commands were changed in the 0.4.7 release:

ATI
 (http://adafru.it/iCs)The chip revision was added after the chip name. Whereas ATI would
previously report 'nRF51822', it will now add the specific HW revision if it can be detected (ex
'nRF51822 QFAAG00')

Version 0.3.0
First public release
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Command Examples
The following code snippets can be used when operating in Command Mode to perform specific
tasks.

Heart Rate Monitor Service
The command list below will add a Heart Rate (http://adafru.it/ddB) service to the BLEFriend's
attribute table, with two characteristics:

Heart Rate Measurement (http://adafru.it/ddD)
Body Sensor Location (http://adafru.it/eck)

# Perform a factory reset to make sure we get a clean start
AT+FACTORYRESET
OK
  
# Add the Heart Rate service entry
AT+GATTADDSERVICE=UUID=0x180D
1
OK

# Add the Heart Rate Measurement characteristic
AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_LEN=2, MAX_LEN=3, VALUE=00-40
1
OK

# Add the Body Sensor Location characteristic
AT+GATTADDCHAR=UUID=0x2A38, PROPERTIES=0x02, MIN_LEN=1, VALUE=3
2
OK

# Create a custom advertising packet that includes the Heart Rate service UUID
AT+GAPSETADVDATA=02-01-06-05-02-0d-18-0a-18
OK

# Reset the device to start advertising with the custom payload
ATZ
OK

# Update the value of the heart rate measurement (set it to 0x004A)
AT+GATTCHAR=1,00-4A
OK
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Python Script

The following code performs the same function, but has been placed inside a Python wrapper using
PySerial (http://adafru.it/cLU) to show how you can script actions for the AT parser.

import io
import sys
import serial
import random
from time import sleep

filename = "hrm.py"
ser = None
serio = None
verbose = True  # Set this to True to see all of the incoming serial data

def usage():
    """Displays information on the command-line parameters for this script"""
    print "Usage: " + filename + " <serialPort>\n"
    print "For example:\n"
    print "  Windows : " + filename + " COM14"
    print "  OS X    : " + filename + " /dev/tty.usbserial-DN009WNO"
    print "  Linux   : " + filename + " /dev/ttyACM0"
    return

def checkargs():
    """Validates the command-line arguments for this script"""
    if len(sys.argv) < 2:
        print "ERROR: Missing serialPort"
        usage()
        sys.exit(-1)
    if len(sys.argv) > 2:
        print "ERROR: Too many arguments (expected 1)."
        usage()
        sys.exit(-2)

def errorhandler(err, exitonerror=True):
    """Display an error message and exit gracefully on "ERROR\r\n" responses"""
    print "ERROR: " + err.message
    if exitonerror:
        ser.close()
        sys.exit(-3)
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def atcommand(command, delayms=0):
    """Executes the supplied AT command and waits for a valid response"""
    serio.write(unicode(command + "\n"))
    if delayms:
        sleep(delayms/1000)
    rx = None
    while rx != "OK\r\n" and rx != "ERROR\r\n":
        rx = serio.readline(2000)
        if verbose:
            print unicode(rx.rstrip("\r\n"))
    # Check the return value
    if rx == "ERROR\r\n":
        raise ValueError("AT Parser reported an error on '" + command.rstrip() + "'")

if __name__ == '__main__':
    # Make sure we received a single argument (comPort)
    checkargs()

    # This will automatically open the serial port (no need for ser.open)
    ser = serial.Serial(port=sys.argv[1], baudrate=9600, rtscts=True)
    serio = io.TextIOWrapper(io.BufferedRWPair(ser, ser, 1),
                             newline='\r\n',
                             line_buffering=True)

    # Add the HRM service and characteristic definitions
    try:
        atcommand("AT+FACTORYRESET", 1000)  # Wait 1s for this to complete
        atcommand("AT+GATTCLEAR")
        atcommand("AT+GATTADDSERVICE=UUID=0x180D")
        atcommand("AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_LEN=2, MAX_LEN=3, VALUE=00-40"
        atcommand("AT+GATTADDCHAR=UUID=0x2A38, PROPERTIES=0x02, MIN_LEN=1, VALUE=3")
        atcommand("AT+GAPSETADVDATA=02-01-06-05-02-0d-18-0a-18")
        # Perform a system reset and wait 1s to come back online
        atcommand("ATZ", 1000)
        # Update the value every second
        while True:
            atcommand("AT+GATTCHAR=1,00-%02X" % random.randint(50, 100), 1000)
    except ValueError as err:
        # One of the commands above returned "ERROR\n"
        errorhandler(err)
    except KeyboardInterrupt:
        # Close gracefully on CTRL+C
        ser.close()
        sys.exit()
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The results of this script can be seen below in the 'HRM' app of Nordic's nRF Toolbox application:

Please note that nRF Toolbox will only display HRM data if the value changes, so you will
need to update the Heart Rate Measurement characteristic at least once after opening the
HRM app and connecting to the BLEFriend

�
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SDEP (SPI Data Transport)
In order to facilitate switching between UART and SPI based Bluefruit LE modules, the Bluefruit LE
SPI Friend and Shield uses the same AT command set at the UART modules ( ATI , AT+HELP ,
etc.).  

These text-based AT commands are encoded as binary messages using a simple binary protocol
we've named SDEP (Simple Data Exhange Protocol).

SDEP Overview
SDEP was designed as a bus neutral protocol to handle binary commands and responses --
including error responses -- in a standard, easy to extend manner. 'Bus neutral' means that we can
use SDEP regardless of the transport mechanism (USB HID, SPI, I2C, Wireless data over the air,
etc.).

All SDEP messages have a four byte header, and in the case of the Bluefruit LE modules up to a
16 byte payloads. Larger messages are broken up into several 4+16 bytes message chunks which
are rebuilt at either end of the transport bus. The 20 byte limit (4 byte header + 16 byte payload)
was chosen to take into account the maximum packet size in Bluetooth Low Energy 4.0 (20 bytes
per packet).

SPI Setup
While SDEP is bus neutral, in the case of the Bluefruit LE SPI Friend or Shield, an SPI transport is
used with the following constraints and assumptions, largely to take into account the HW limitations
of the nRF51822 system on chip:

SPI Hardware Requirements

The SPI clock should run <=4MHz
A 100us delay should be added between the moment that the CS line is asserted, and before
any data is transmitted on the SPI bus
The CS line must remain asserted for the entire packet, rather than toggling CS every byte

IRQ Pin

The IRQ line is asserted by the Bluefruit LE SPI Friend/Shield as long as an entire SDEP packet is
available in the buffer on the nRF51822, at which point you should read the packet, keeping the CS
line asserted for the entire transaction (as detailed above).

Most of the time, you never need to deal with SDEP directly, but we've documented the
protocol here in case you need understand the Bluefruit LE SPI interface in depth!�

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 148 of 170



The IRQ line will remain asserted as long as one or more packets are available, so the line may stay
high after reading a packet, meaning that more packets are still available in the FIFO on the SPI
slave side.

SDEP Packet and SPI Error Identifier

Once CS has been asserted and the mandatory 100us delay has passed, a single byte should be
read from the SPI bus which will indicate the type of payload available on the nRF51822 (see
Message Type Indicator below for more information on SDEP message types). Keep CS asserted
after this byte has been read in case you need to continue reading the rest of the frame.

If a standard SDEP message type indicator (0x10, 0x20, 0x40 or 0x80) is encountered, keep
reading as normal. There are two other indicators that should be taken into account, though, which
indicate a problem on the nRF51822 SPI slave side:

0xFE: Slave device not ready (wait a bit and try again)
0xFF: Slave device read overflow indicator (you've read more data than is available)

Sample Transaction

The following image shows a sample SDEP response that is spread over two packets (since the
response is > 20 bytes in size). Notice that the IRQ line stays asserted between the packets since
more than one was available in the FIFO on the Bluefruit LE SPI side:

SDEP (Simple Data Exchange Protocol)
The Simple Data Exchange Protocol (SDEP) can be used to send and receive binary messages
between two connected devices using any binary serial bus (USB HID, USB Bulk, SPI, I2C, Wireless,
etc.), exchanging data using one of four distinct message types (Command, Response, Alert and
Error messages).

The protocol is designed to be flexible and extensible, with the only requirement being that
individual messages are 20 bytes or smaller, and that the first byte of every message is a one
byte (U8) identifier that indicates the message type, which defines the format for the remainder of
the payload.
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Endianness

All values larger than 8-bits are encoded in little endian format. Any deviation from this rule should
be clearly documented.

Message Type Indicator

The first byte of every message is an 8-bit identifier called the Message Type Indicator. This value
indicates the type of message being sent, and allows us to determine the format for the remainder
of the message.

SDEP Data Transactions

Either connected device can initiate SDEP transactions, though certain transport protocols imposes
restrictions on who can initiate a transfer. The master device, for example, always initiates
transactions with Bluetooth Low Energy or USB, meaning that slave devices can only reply to
incoming commands.

Every device that receives a Command Message must reply with a Response Message, Error
Message or Alert message.

Message Types

Command Messages

Command messages (Message Type = 0x10) have the following structure:

Message Type

Command

Response

Alert

Error

ID (U8)

0x10

0x20

0x40

0x80
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Command ID (bytes 1-2) and Payload Length (byte 3) are mandatory in any command message.
The message payload is optional, and will be ignored if Payload Length is set to 0 bytes. When a
message payload is present, it’s length can be anywhere from 1..16 bytes, to stay within the 20-byte
maximum message length.

A long command (>16 bytes payload) must be divided into multiple packets. To facilitate this, the
More data field (bit 7 of byte 3) is used to indicate whether additional packets are available for the
same command. The SDEP receiver must continue to reads packets until it finds a packet with More
data == 0, then assemble all sub-packets into one command if necessary.

The contents of the payload are user defined, and can change from one command to another.

A sample command message would be:

The first byte is the Message Type (0x10), which identifies this as a command message.
The second and third bytes are 0x1234 (34 12 in little-endian notation), which is the unique
command ID. This value will be compared against the command lookup table and redirected
to an appropriate command handler function if a matching entry was found.
The fourth byte indicates that we have a message payload of 1 byte
The fifth byte is the 1 byte payload: 0xFF

Name

Message Type

Command ID

Payload Length

 

 

Payload

Type

U8

U16

U8

 

 

...

Meaning

Always '0x10'

Unique Command Identifier

[7] More data 
[6-5] Reserved 
[4-0] Payload length (0..16)

Optional command payload (parameters, etc.)

10 34 12 01 FF

0: Message Type (U8)

1+2: Command ID (U16)

3: Payload Len (U8)

4: Payload (...)

0x10

0x34 0x12

0x01

0xFF
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Response Messages

Response messages (Message Type = 0x20) are generated in response to an incoming command,
and have the following structure:

By including the Command ID that this response message is related to, the recipient can more
easily correlate responses and commands. This is useful in situations where multiple commands are
sent, and some commands may take a longer period of time to execute than subsequent
commands with a different command ID.

Response messages can only be generate in response to a command message, so the Command
ID field should always be present.

A long response (>16 bytes payload) must be divided into multiple packets. Similar to long
commands, the More data field (bit 7 of byte 3) is used to indicate whether additional packets are
available for the same response. On responses that span more than one packet, the More data bit
on the final packet will be set to 0 to indicate that this is the last packet in the sequence. The SDEP
receiver must re-assemble all sub-packets in into one payload when necessary.

If more precise command/response correlation is required a custom protocol should be developed,
where a unique message identifier is included in the payload of each command/response, but this is
beyond the scope of this high-level protocol definition.

A sample response message would be:

Name

Message Type

Command ID

Payload Length

 

 

Payload

Type

U8

U16

U8

  

 

 

Meaning

Always  '0x20'

Command ID this message is a response to

[7] More data 
[6-5] Reserved 
[4-0] Payload length (0..16)

Optional response payload (parameters, etc.)

20 34 12 01 FF

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 152 of 170



The first byte is the Message Type (0x20), which identifies this as a response message.
The second and third bytes are 0x1234, which is the unique command ID that this response
is related to.
The fourth byte indicates that we have a message payload of 1 byte.
The fifth byte is the 1 byte payload: 0xFF

Alert Messages

Alert messages (Message Type = 0x40) are sent whenever an alert condition is present on the
system (low battery, etc.), and have the following structure:

A sample alert message would be:

The first byte is the Message Type (0x40), which identifies this as an alert message.
The second and third bytes are 0xABCD, which is the unique alert ID.

0: Message Type (U8)

1+2: Command ID (U16)

3: Payload Len (U8)

4: Payload

0x20

0x34 0x12

0x01

0xFF

Name

Message Type

Alert ID

Payload Length

Payload

Type

U8

U16

U8

...

Meaning

Always '0x40'

Unique ID for the Alert Condition

Payload Length (0..16)

Optional response payload

40 CD AB 04 42 07 00 10

0: Message Type (U8)

1+2: Alert ID (U16)

3: Payload Length

4+5+6+7: Payload

0x40

0xCD 0xAB

0x04

0x42 0x07 0x00 0x10
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The fourth byte indicates that we have a message payload of 4 bytes.
The last four bytes are the actual payload: 0x10000742 in this case, assuming we were
transmitting a 32-bit value in little-endian format.

Standard Alert IDs

Alert IDs in the range of 0x0000 to 0x00FF are reserved for standard SDEP alerts, and may not be
used by custom alerts.

The following alerts have been defined as a standard part of the protocol:

Error Messages

Error messages (Message Type = 0x80) are returned whenever an error condition is present on the
system, and have the following structure:

Whenever an error condition is present and the system needs to be alerted (such as a failed
request, an attempt to access a non-existing resource, etc.) the system can return a specific error
message with an appropriate Error ID.

A sample error message would be:

ID

0x0000

0x0001

0x0002

0x0003

Alert

Reserved

System Reset

Battery Low

Battery Critical

Description

Reserved for future use

The system is about to reset

The battery level is low

The battery level is critically low

Name

Message Type

Error ID

Reserved

Type

U8

U16

U8

Meaning

Always '0x80'

Unique ID for the error condition

Reserved for future use

80 01 00 00
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Standard Error IDs

Error IDs in the range of 0x0000 to 0x00FF are reserved for standard SDEP errors, and may not be
used by custom errors.

The following errors have been defined as a standard part of the protocol:

0: Message ID (U8)

1+2: Error ID (U16)

3: Reserved (U8)

0x80

0x01 0x00

0x00

ID

0x0000

0x0001

0x0003

Error

Reserved

Invalid CMD ID

Invalid Payload

Description

Reserved for future use

CMD ID wasn't found in the lookup table

The message payload was invalid
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GATT Service Details
Data in Bluetooth Low Energy is organized around units called 'GATT Services (http://adafru.it/iCp)'
and 'GATT Characteristics'.  To expose data to another device, you must instantiate at least one
service on your device.

Adafruit's Bluefruit LE Pro modules support some 'standard' services, described below (more may
be added in the future).

UART Service

The UART Service is the standard means of sending and receiving data between connected
devices, and simulates a familiar two-line UART interface (one line to transmit data, another to
receive it).

The service is described in detail on the dedicated UART Service (http://adafru.it/iCn) page.
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UART Service
Base UUID: 6E400001-B5A3-F393-�E0A9-�E50E24DCCA9E

This service simulates a basic UART connection over two lines, TXD and RXD.

It is based on a proprietary UART service specification by Nordic Semiconductors. Data sent to and
from this service can be viewed using the nRFUART apps from Nordic Semiconductors for Android
and iOS.

Characteristics
Nordic’s UART Service includes the following characteristics:

R = Read; W = Write; N = Notify; I = Indicate

TX (0x0002)

This characteristic is used to send data back to the sensor node, and can be written to by the
connected Central device (the mobile phone, tablet, etc.).

RX (0x0003)

This characteristic is used to send data out to the connected Central device. Notify can be enabled
by the connected device so that an alert is raised every time the TX channel is updated.

This service is available on every Bluefruit LE module and is automatically started during the
power-up sequence.�

Name
TX
RX

Mandatory
Yes
Yes

UUID
0x0002
0x0003

Type
U8[20]
U8[20]

R

X

W
X

N

X

I

Characteristic names are assigned from the point of view of the Central device�
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Software Resources
To help you get your Bluefruit LE module talking to other Central devices, we've put together a
number of open source tools for most of the major platforms supporting Bluetooth Low Energy.

Bluefruit LE Client Apps and Libraries
Adafruit has put together the following mobile or desktop apps and libraries to make it as easy as
possible to get your Bluefruit LE module talking to your mobile device or laptop, with full source
available where possible:

Bluefruit LE Connect (http://adafru.it/f4G) (Android/Java)

Bluetooth Low Energy support was added to Android starting with Android 4.3 (though it was only
really stable starting with 4.4), and we've already released Bluefruit LE Connect to the Play
Store (http://adafru.it/f4G).

The full source code (http://adafru.it/fY9) for Bluefruit LE Connect for Android is also available on
Github to help you get started with your own Android apps.  You'll need a recent version of Android
Studio (http://adafru.it/fYa) to use this project.

Bluefruit LE Connect (http://adafru.it/f4H) (iOS/Swift)

Apple was very early to adopt Bluetooth Low Energy, and we also have an iOS version of the
Bluefruit LE Connect (http://adafru.it/f4H) app available in Apple's app store.

The full Swift source code (http://adafru.it/ddv) for Bluefruit LE Connect for iOS is also available on
Github. You'll need XCode and access to Apple's developper program to use this project.
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ABLE (http://adafru.it/ijB) (Cross Platform/Node+Electron)

ABLE (http://adafru.it/ijB) (Adafruit Bluefruit LE Desktop) is a cross-platform desktop application
based on Sandeep Misty's noble library (http://adafru.it/ijC) and the
Electron (http://adafru.it/ijD) project from Github (used by Atom).

It runs on OS X, Windows 7+ and select flavours of Linux (Ubuntu tested locally).  Windows 7
support is particularly interesting since Windows 7 has no native support for Bluetooth Low Energy
but the noble library talks directly to supported Bluetooth 4.0 USB dongles (http://adafru.it/1327) to
emulate BLE on the system (though at this stage it's still in early BETA and drops the connection
and takes more care to work with).

This app allows you to collect sensor data or perform many of the same functionality offered by the
mobile Bluefruit LE Connect apps, but on the desktop.

The app is still in BETA, but full source (http://adafru.it/ijE) is available in addition to the easy to use
pre-compiled binaries (http://adafru.it/ijB).
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Bluefruit LE Python Wrapper (http://adafru.it/fQF)

As a proof of concept, we've played around a bit with getting Python working with the native
Bluetooth APIs on OS X and the latest version of Bluez on certain Linux targets.

There are currently example sketches showing how to retreive BLE UART data as well as some
basic details from the Device Information Service (DIS).

This isn't an actively support project and was more of an experiment, but if you have a recent
Macbook or a Raspberry Pi and know Python, you might want to look at
Adafruit_Python_BluefruitLE (http://adafru.it/fQF) in our github account.

Debug Tools
If your sense of adventure gets the better of you, and your Bluefruit LE module goes off into the
weeds, the following tools might be useful to get it back from unknown lands.

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 160 of 170

https://github.com/adafruit/Adafruit_Python_BluefruitLE
https://github.com/adafruit/Adafruit_Python_BluefruitLE


AdaLink (http://adafru.it/fPq) (Python)

This command line tool is a python-based wrapper for programming ARM MCUs using either a
Segger J-Link (http://adafru.it/fYU) or an STLink/V2 (http://adafru.it/ijF). You can use it to reflash
your Bluefruit LE module using the latest firmware from the Bluefruit LE firmware
repo (http://adafru.it/edX).

Details on how to use the tool are available in the readme.md file on the main
Adafruit_Adalink (http://adafru.it/fPq) repo on Github.

Completely reprogramming a Bluefruit LE module with AdaLink would require four files, and would
look something like this (using a JLink):

You can also use the AdaLink tool to get some basic information about your module, such as which
SoftDevice is currently programmed or the IC revision (16KB SRAM or 32KB SRAM) via the --info
command:

Adafruit nRF51822 Flasher (http://adafru.it/fVL) (Python)

Adafruit's nRF51822 Flasher is an internal Python tool we use in production to flash boards as they
go through the test procedures and off the assembly line, or just testing against different firmware
releases when debugging.

These debug tools are provided purely as a convenience for advanced users for device
recovery purposes, and are not recommended unless you're OK with potentially bricking your
board. Use them at your own risk.

�

adalink nrf51822 --programmer jlink --wipe
  --program-hex "Adafruit_BluefruitLE_Firmware/softdevice/s110_nrf51_8.0.0_softdevice.hex" 
  --program-hex "Adafruit_BluefruitLE_Firmware/bootloader/bootloader_0002.hex"
  --program-hex "Adafruit_BluefruitLE_Firmware/0.6.7/blefriend32/blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex"
  --program-hex "Adafruit_BluefruitLE_Firmware/0.6.7/blefriend32/blefriend32_s110_xxac_0_6_7_150917_blefriend32_signature.hex"

$ adalink nrf51822 -p jlink --info
Hardware ID : QFACA10 (32KB)
Segger ID   : nRF51822_xxAC
SD Version  : S110 8.0.0
Device Addr : **:**:**:**:**:**
Device ID   : ****************
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It relies on AdaLink or OpenOCD beneath the surface (see above), but you can use this command
line tool to flash your nRF51822 with a specific SoftDevice, Bootloader and Bluefruit firmware
combination.

It currently supports using either a Segger J-Link or STLink/V2 via AdaLink, or GPIO on a Raspberry
Pi (http://adafru.it/fVL) if you don't have access to a traditional ARM SWD debugger.  (A pre-built
version of OpenOCD for the RPi is included in the repo since building it from scratch takes a long
time on the original RPi.)

We don't provide active support for this tool since it's purely an internal project, but made it public
just in case it might help an adventurous customer debrick a board on their own.

$ python flash.py --jtag=jlink --board=blefriend32 --softdevice=8.0.0 --bootloader=2 --firmware=0.6.7
jtag        : jlink
softdevice  : 8.0.0
bootloader  : 2
board       : blefriend32
firmware    : 0.6.7
Writing Softdevice + DFU bootloader + Application to flash memory
adalink -v nrf51822 --programmer jlink --wipe --program-hex "Adafruit_BluefruitLE_Firmware/softdevice/s110_nrf51_8.0.0_softdevice.hex"
...

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-32u4-bluefruit-le Page 162 of 170

https://github.com/adafruit/Adafruit_nRF51822_Flasher#rpi-gpio-requirements


�

�

�

�

BLE FAQ
Can I talk to Classic Bluetooth devices with a Bluefruit LE modules?

No.  Bluetooth Low Energy and 'Classic' Bluetooth are both part of the same Bluetooth Core
Specification -- defined and maintained by the Bluetooth SIG -- but they are completely different
protocols operating with different physical constraints and requirements.  The two protocols can't
talk to each other directly.

Can my Bluefruit LE module connect to other Bluefruit LE peripherals
No, the Bluefruit LE firmware from Adafruit is currently peripheral only, and doesn't run in Central
mode, which would cause the module to behave similar to your mobile phone or BLE enabled
laptop.

At some point we might consider a new firmware image offering this, but since 98% of the uses
cases for BLE involved running as a peripheral we've concentrated all of our development effort
there for now.

Why are none of my changes persisting when I reset with the sample sketches?
In order to ensure that the Bluefruit LE modules are in a known state for the Adafruit demo
sketches, most of them perform a factory reset at the start of the sketch.

This is useful to ensure that the sketch functions properly, but has the side effect of erasing any
custom user data in NVM and setting everything back to factory defaults every time your board
comes out of reset and the sketch runs.

To disable factory reset, open the demo sketch and find the FACTORYRESET_ENABLE flag
and set this to '0', which will prevent the factory reset from happening at startup.

If you don't see the 'FACTORYRESET_ENABLE' flag in your .ino sketch file, you probably have
an older version of the sketches and may need to update to the latest version via the Arduino
library manager.

Do I need CTS and RTS on my UART based Bluefruit LE Module?
Using CTS and RTS isn't strictly necessary when using HW serial, but they should both be used
with SW serial, or any time that a lot of data is being transmitted.

The reason behind the need for CTS and RTS is that the UART block on the nRF51822 isn't very
robust, and early versions of the chip had an extremely small FIFO meaning that the UART
peripheral was quickly overwhelmed.

Using CTS and RTS significantly improves the reliability of the UART connection since these two
pins tell the device on the other end when they need to wait while the existing buffered data is
processed.
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To enable CTS and RTS support, go into the BluefruitConfig.h file in your sketch folder and
simply assign an appropriate pin to the macros dedicated to those functions (they may be set to -
1 if they aren't currently being used).

Enabling both of these pins should solve any data reliability issues you are having with large
commands, or when transmitting a number of commands in a row.

How can I update to the latest Bluefruit LE Firmware?
The easiest way to keep your Bluefruit LE modules up to date is with our Bluefruit LE Connect
app for Android (http://adafru.it/f4G) or Bluefruit LE Connect for iOS (http://adafru.it/f4H).  Both of
these apps include a firmware update feature that allows you to automatically download the
latest firmware and flash your Bluefruit LE device in as safe and painless a manner as possible.
You can also roll back to older versions of the Bluefruit LE firmware using these apps if you need
to do some testing on a previous version.

Which firmware version supports 'xxx'?
We regularly release Bluefruit LE firmware images (http://adafru.it/edX) with bug fixes and new
features. Each AT command in this learning guide lists the minimum firmware version required to
use that command, but for a higher level overview of the changes from one firmware version to
the next, consult the firmware history page (http://adafru.it/iCw).

Does my Bluefruit LE device support ANCS?
ANCS is on the roadmap for us (most likely in the 0.7.x release family), but we don't currently
support it since there are some unusual edge cases when implementing it as a service.

My Bluefruit LE device is stuck in DFU mode ... what can I do?
If your device is stuck in DFU mode for some reason and the firmware was corrupted, you have
several options.

First, try a factory reset by holding down the DFU button for about 10 seconds until the CONN
LED starts flashing, then release the DFU button to perform a factory reset. 

If this doesn't work, you may need to reflash your firmware starting from DFU mode, which can
be done in one of the following ways:

Bluefruit LE Connect (Android)

Place the module in DFU mode (constant LED blinky)
Open Bluefruit LE Connect
Connect to the 'DfuTarg' device
Once connected, you will see a screen with some basic device information. Click the '...' in
the top-right corner and select Firmware Updates
Click the Use Custom Firmware button
Select the appropriate .hex and .init files (copied from the Bluefruit LE Firmware
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repo (http://adafru.it/edX)) ... for the BLEFRIEND32 firmware version 0.6.7, this would be:
Hex File: blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex
Init File: blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat

Click Start Update

Unfortunately, the iOS app doesn't yet support custom firmware updates from DFU mode yet,
but we will get this into the next release.

Nordic nRF Toolbox

You can also use Nordic's nRF Toolbox application to update the firmware using the OTA
bootloader.

On Android:

Open nRF Toolbox (using the latest version)
Click the DFU icon
Click the Select File button
Select Application from the radio button list, then click OK
Find the appropriate .hex file
(ex. 'blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex')
When asked about the 'Init packet', indicate Yes, and select the appropriate *_init.dat file
(for example: 'blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat').
Click the Select Device button at the bottom of the main screen and find the DfuTarg
device, clicking on it
Click the Upload button, which should now be enabled on the home screen
This will begin the DFU update process which should cause the firmware to be updated or
restored on your Bluefruit LE module

On iOS:

Create a .zip file containing the .hex file and init.dat file that you will use for the firmware
update.  For example:

Rename
'blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex' to application.hex
Rename 'blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat'
to application.dat

Upload the .zip file containing the application.hex and application.dat files to your iPhone
using uTunes, as described here (http://adafru.it/iCx)
Open the nRF Toolbox app (using the latest version)
Click the DFU icon
Click the Select File text label
Switch to User Files to see the .zip file you uploaded above
Select the .zip file (ex. blefriend32_065.zip)
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On the main screen select Select File Type
Select application
On the main screen select SELECT DEVICE
Select DfuTarg
Click the Upload button which should now be enabled
This will begin the DFU process and your Bluefruit LE module will reset when the update is
complete
If you get the normal 2 or 3 pulse blinky pattern, the update worked!

Adafruit_nRF51822_Flasher

As a last resort, if you have access to a Raspberry Pi, a Segger J-Link or a STLink/V2, you can
also try manually reflashing the entire device, as described in the FAQ
above (http://adafru.it/iCy), with further details on the Software
Resources (http://adafru.it/iCz) page.

How do I reflash my Bluefruit LE module over SWD?
Reflashing Bluefruit LE modules over SWD (ex. switching to the sniffer firmware and back) is at
your own risk and can lead to a bricked device, and we can't offer any support for this
operation!  You're on your own here, and there are unfortunately 1,000,000 things that can go
wrong, which is why we offer two separate Bluefruit LE Friend boards -- the sniffer and the
normal Bluefruit LE Friend board with the non-sniffer firmware, which provides a bootloader with
fail safe features that prevents you from ever bricking boards via OTA updates.

AdaLink (SWD/JTAG Debugger Wrapper)

Transitioning between the two board types (sniffer and Bluefruit LE module) is unfortunately not
a risk-free operation, and requires external hardware, software and know-how to get right, which
is why it isn't covered by our support team.

That said ... if you're determined to go down that lonely road, and you have a Segger J-
Link (http://adafru.it/fYU) (which is what we use internally for production and development),
or have already erased your Bluefruit LE device, you should have a look at
AdaLink (http://adafru.it/fPq), which is the tool we use internally to flash the four files required to
restore a Bluefruit LE module. (Note: recent version of AdaLink also support the cheaper
STLink/V2 (http://adafru.it/2548), though the J-Link is generally more robust if you are going to
purchase a debugger for long term use.)

The mandatory Intel Hex files are available in the Bluefruit LE Firmware
repo (http://adafru.it/edX). You will need to flash: 

An appropriate bootloader image
An appropriate SoftDevice image
The Bluefruit LE firmware image
The matching signature file containing a CRC check so that the bootloader accepts the
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firmware image above (located in the same folder as the firmware image)

The appropriate files are generally listed in the version control .xml file (http://adafru.it/fPr) in the
firmware repository.

If you are trying to flash the sniffer firmware (at your own risk!), you only need to flash a single
.hex file, which you can find here (http://adafru.it/fYV). The sniffer doesn't require a SoftDevice
image, and doesn't use the fail-safe bootloader -- which is why changing is a one way and risky
operation if you don't have a supported SWD debugger.

Adafruit_nF51822_Flasher

We also have an internal python tool available that sits one level higher than AdaLink
(referenced above), and makes it easier to flash specific versions of the official firmware to a
Bluefruit LE module.  For details, see the Adafruit_nRF51822_Flasher (http://adafru.it/fVL) repo.

Can I access BETA firmware releases?
The latest versions of the Bluefruit LE Connect applications for iOS and Android allow you to
optionally update your Bluefruit LE modules with pre-release or BETA firmware.  

This functionality is primarilly provided as a debug and testing mechanism for support issues in
the forum, and should only be used when trying to identify and resolve specific issues with your
modules!

Enabling BETA Releases on iOS

Make sure you have at least version 1.7.1 of Bluefruit LE Connect
Go to the Settings page
Scroll to the bottom of the Settings page until you find Bluefruit LE
Click on the Bluefruit LE icon and enable the Show beta releases switch
You should be able to see any BETA releases available in the firmware repo now when
you use Bluefruit LE Connect

Enabling BETA Releases on Android

Make sure you have the latest version of Bluefruit LE Connect
Open the Bluefruit LE Connect application
Click the "..." icon in the top-right corner of the app's home screen
Select Settings
Scroll down to the Software Updates section and enable Show beta releases
You should be able to see any BETA releases available in the firmware repo now when
you use Bluefruit LE Connect

Why can't I see my Bluefruit LE device after upgrading to Android 6.0?
In Android 6.0 there were some important security changes (http://adafru.it/jcU) that affect
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Bluetooth Low Energy devices.  If location services are unavailable (meaning the GPS is turned
off) you won't be able to see Bluetooth Low Energy devices advertising either. See this
issue (http://adafru.it/jcV) for details.

Be sure to enable location services on your Android 6.0 device when using Bluefruit LE Connect
or other Bluetooth Low Energy applications with your Bluefruit LE modules.

What is the theoretical speed limit for BLE?
This depends on a variety of factors, and is determined by the capabilities of the central device
(the mobile phone, etc.) as much as the peripheral.

Taking the HW limits on the nR51822 into account (max 6 packets per connection interval, and a
minimum connection interval of 7.5ms) you end up with the following theoretical limits on various
mobile operating systems:

iPhone 5/6 + IOS 8.0/8.1
6 packets * 20 bytes * 1/0.030 s = 4 kB/s = 32 kbps
iPhone 5/6 + IOS 8.2/8.3
3 packets * 20 bytes * 1/0.030 s = 2 kB/s = 16 kbps
iPhone 5/6 + IOS 8.x with nRF8001
1 packet * 20 bytes * 1/0.030 s = 0.67 kB/s = 5.3 kbps
Nexus 4
4 packets * 20 bytes * 1/0.0075 s = 10.6 kB/s = 84 kbps
Nordic Master Emulator Firmware (MEFW) with nRF51822 0.9.0
1 packet * 20 bytes * 1/0.0075 = 2.67 kB/s = 21.33 kbps
Nordic Master Emulator Firmware (MEFW) with nRF51822 0.11.0
6 packets * 20 bytes * 1/0.0075 = 16 kB/s = 128 kbps

There are also some limits imposed by the Bluefruit LE firmware, but we are actively working to
significantly improve the throughput in the upcoming 0.7.0 release, which will be available Q1
2015.  The above figures are useful as a theoretical maximum to decide if BLE is appropriate for
you project or not.
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DFU Bluefruit Updates
You can reprogram the Bluefruit LE module itself over-the-air using an Android or iOS phone/tablet.
This doesn't reprogram the ATmega32u4 in the Bluefruit Micro, only the BLE module itself. Since its
not a common thing to do, its a little challenging to do.

You will need to disconnect/unpower the Bluefruit Micro, connect a wire temporarily between the
DFU pin and GND and then power up the board via USB or battery.

The red LED will blink continuously, letting you know it's in DFU mode. Then follow our guide for
field updating the firmware  (http://adafru.it/iCQ)
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